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1 Safety
To prevent possible electrical shock, fire, personal injury, or damage to the product, carefully read this
safety information before attempting to install or use the product. In addition, follow all generally
accepted safety practices and procedures for working with and near electricity.

This instrument and accessories have been designed to meet the requirements of EN 61010-1 (Safety
Requirements for Electrical Equipment for Measurement, Control and Laboratory Use).

The following safety descriptions are found throughout this guide:

A WARNING identifies conditions or practices that could result in injury or death.

A CAUTION identifies conditions or practices that could result in damage to the product or equipment to
which it is connected.

WARNING
This product is for professional use by trained and qualified technicians only. To prevent
injury or death, use the product only as instructed and use only accessories that have been
supplied or recommended by Pico Technology. Protection provided by the product may be
impaired if used in a manner not specified by the manufacturer.

1.1 Symbols
These safety and electrical symbols may appear on the product or in this guide.

Symbol Description

Earth (ground) terminal
This terminal can be used to make a measurement ground
connection. It is NOT a safety or protective earth.

Chassis terminal

Possibility of electric shock

CAUTION
Appearance on the product indicates a need to read these
safety instructions.

Do not dispose of this product as unsorted municipal waste.

1.2 Maximum input/output ranges

WARNING
To prevent electric shock, do not attempt to measure or apply signal levels outside the
specified maxima below.
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The table below indicates the maximum voltage of the outputs and the overvoltage protection range for
each input on the VNA and its calibration accessories. The overvoltage protection ranges are the
maximum voltages that can be applied without damaging the instrument or accessory.

Instrument Connectors Maximum operating voltage
(output or input)

Overvoltage or overcurrent
protection

Ports 1 and 2 +10 dBm (about 710 mV RMS) +20 dBm (about 2.2 V RMS)

Bias tees 1 and 2 ±15 V DC 250 mA

Trigger and reference in ±6 V pk

Trigger and reference out 0 V to +5 V Do not apply a voltage

Calibration Accessory
Connector/Overvoltage
Protection

N/A
SOLT-AUTO Ports A / B, SOLT-
PREM and SOLT-STD Ports = +20
dBm

WARNING
Signals exceeding the voltage limits in the table below are defined as "hazardous live" by EN
61010.

Signal voltage limits of EN61010

± 60 V DC 30 V AC RMS ± 42.4 V pk max.

WARNING
To prevent electric shock, take all necessary safety precautions when working on equipment
where hazardous live voltages may be present.

WARNING
To avoid equipment damage and possible injury, do not operate the instrument or an
accessory outside its rated supply voltages or environmental range.

CAUTION
Exceeding the overvoltage protection range on any connector can cause permanent damage
to the instrument and other connected equipment.
To prevent permanent damage, do not apply an input voltage to the trigger or reference output
of the VNA.

1.3 Grounding

WARNING
The instrument or SOLT-AUTO E-Cal module's ground connection through the USB cable is
for functional purposes only. The instrument does not have a protective safety ground.

WARNING
To prevent injury or death, or permanent damage to the instrument, never connect the ground
of an input or output (chassis) to any electrical power source. To prevent personal injury or
death, use a voltmeter to check that there is no significant AC or DC voltage between the
instrument’s ground and the point to which you intend to connect it.t it.

CAUTION
To prevent signal degradation caused by poor grounding, always use the high-quality USB
cable supplied with the instrument.
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1.4 External connections

WARNING
To prevent injury or death, only use the power adaptor supplied with the instrument. This is
approved for the voltage and plug configuration in your country.

Power supply options and ratings

Model name USB connection
Ext DC power supply

Voltage Current Total power

PicoVNA 106
USB 2.0. 

Compatible with
USB 3.0

12 to 15 V DC 1.85 A pk
22 W

PicoVNA 108 25 W

SOLT-AUTO E-Cal
module

N/A

WARNING
Containment of radio frequencies
The instrument contains a swept or CW radio frequency signal source (300 kHz to 6.02 GHz
at +6 dBm max. for the PicoVNA 106, 300 kHz to 8.50 GHz at +6 dBm max. for the PicoVNA
108) The instrument and supplied accessories are designed to contain and not radiate (or be
susceptible to) radio frequencies that could interfere with the operation of other equipment
or radio control and communications. To prevent injury or death, connect only to
appropriately specified connectors, cables, accessories and test devices, and do not connect
to an antenna except within approved test facilities or under otherwise controlled conditions.

1.5 Environment

WARNING
This product is suitable for indoor or outdoor use, in dry locations only. The product’s
external mains power supply is for indoor use only

WARNING
To prevent injury or death, do not use the VNA or an accessory in wet or damp conditions, or
near explosive gas or vapor.

CAUTION
To prevent damage, always use and store your VNA or accessory in appropriate
environments.

Storage Operating

Temperature –20 to +50 °C +5 to +40 °C

Humidity 20% to 80 %RH (non-condensing)

Altitude 2000 m

Pollution degree 2

CAUTION
Do not block the air vents at the back or underside of the instrument as overheating will
cause damage.

Do not insert any objects through the air vents as internal interference will cause damage.
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1.6 Care of the product
The product and accessories contain no user-serviceable parts. Repair, servicing and calibration require
specialized test equipment and must only be performed by Pico Technology or an approved service
provider. There may be a charge for these services unless covered by the Pico three-year warranty.

WARNING
To prevent injury or death, do not use the VNA or accessory if it appears to be damaged in
any way, and stop use immediately if you are concerned by any abnormal behavior.

CAUTION
Regularly inspect the instrument and all probes, connectors, cables and accessories before
use for signs of damage or contamination.

To prevent damage to the device or connected equipment, do not tamper with or disassemble
the instrument, case parts, connectors, or accessories.

When cleaning the product, use a soft cloth and a solution of mild soap or detergent in water,
and do not allow liquids to enter the casing of the instrument or accessory.

Take care to avoid mechanical stress or tight bend radii for all connected leads, including all
coaxial leads and connectors. Mishandling will cause deformation of sidewalls, and will
degrade performance. In particular, note that test port leads should not be formed to tighter
than 5 cm (2”) bend radius.

To prevent measurement errors and extend the useful life of test leads and accessory
connectors, ensure that liquid and particulate contaminants cannot enter. Always fit the dust
caps provided and use the correct torque when tightening. Pico recommends: 1 Nm (8.85
inch-lb) for supplied and all stainless steel connectors, or 0.452 Nm (4.0 inch-lb) when a brass
or gold plated connector is interfaced.
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2 Quick start guide

2.1 Installing the software
· Obtain the PicoVNA 3 software from www.picotech.com/downloads

· Connect the PicoVNA unit to the computer and wait while Windows automatically installs the driver.

In case of difficulties, refer to Software installation for more details.

Mixer measurements (PicoVNA 108 only)
Control of the PicoSource AS108 300 kHz to 8 GHz signal source is built into the PicoVNA software. If
you wish to carry out mixer measurements using other sources or sensors it is very likely that you will

need to install the Keysight® IO Libraries Suite to support communication with external instruments
through either the USB or GPIB interfaces. Please see www.keysight.com for details.

2.2 Loading the calibration kit(s)

For manual SOLT calibration:

· Run the PicoVNA 3 software

· In the main menu, select Tools > Calibration kit

· Click Load P1 kit, select the data for your Port 1 kit and then click Apply

· Click Load P2 kit, select the data for your Port 2 kit and then click Apply

Select the calibration kit(s) required depending on the device to be tested. 

Note: If testing a non-insertable DUT with, for example, female connectors, use a single female kit for
ports 1 and 2.

For the PicoVNA 108 and an automated calibration:

· Run the PicoVNA 3 software

· Connect the E-Cal module to a spare USB port on the controlling PC

· In the main menu, select Tools > Calibration kit

· Click Electronic Cal kit 

http://www.picotech.com/downloads
http://www.keysight.com
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· Select the E-Cal module and Port Adaptor arrangement to suit the test ports

· Connect the E-Cal module, port adaptor and test ports to exactly match the selected configuration

· Click Find and load EasyCal data

· Upon completion select Exit

· Then click Apply in the Calibration Kit Parameters menu

2.3 Setting up calibration parameters
· Click Calibration to open the Calibration window:
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2.4 Setting up display parameters
See Display Setup for details on using the mouse to set values.

· Click Display in the main window to open the Display Set Up window:

The Display Set Up window is used to set up the measurements display

· When finished, click Start in the main window to begin measurements

2.5 Calibration tips
The bandwidth setting used during calibration largely determines the available dynamic range during the
measurement. The table below shows suggested bandwidth and power settings to use during calibration
for different types of measurement.

Measurement Calibration
bandwidth

Calibration
averaging

Calibration
power

Comments

Fastest speed 10 kHz None +0 dBm Set bandwidth to 140 kHz during measurement

Best accuracy and ~100 dB
dynamic range

100 Hz None –3 dBm Leave bandwidth set to 100 Hz during
measurement

General use, fast speed,
~90 dB dynamic range

1 kHz None +0 dBm Leave bandwidth set to 1 kHz during
measurement

Best dynamic range 10 Hz None +6 dBm Leave bandwidth set to 10 Hz during
measurement. Refer to “Calibration for best
dynamic range – minimizing the effect of
crosstalk”.
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2.6 Running in demo mode
Demo mode allows you to explore the user interface software with no instrument connected. 

· To enter demo mode, run the PicoVNA 3 software with no instrument connected. 

· For demo mode, click Ignore in the dialog that appears.

The software will then offer you a selection of demonstration measurements.
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3 Description
The PicoVNA 106 and 108 are PC-driven vector network analyzers capable of direct measurement of
forward and reverse parameters. The main characteristics are as follows:

Model PicoVNA 106 PicoVNA 108

Operating frequency range 300 kHz to 6 GHz 300 kHz to 8.5 GHz

Dynamic range ≤ 118 dB ≤ 124 dB

Frequency resolution ≤ 10 Hz ≤ 10 Hz

A simplified block diagram of the instrument is shown below:

Simplified block diagram of the PicoVNA units

The architecture is based on a four-receiver (Quad RX) arrangement using a bandwidth of up to 140 kHz.
Couplers A and B are wideband RF bridge components which provide the necessary directivity in both
directions. Signal detection is by means of analog-to-digital converters used to sample the IF signal. The
sample data is processed by the embedded controller to yield the I and Q components. The detection
system operates with an IF of 1.3 MHz and employs a patented circuit technique to yield fast speeds with
very low trace noise.

The instrument's software runs on a personal computer and communication with the instrument is
through the USB interface. The software carries out the mathematical processing and allows the display
of measured parameters in many forms, including: 

· frequency domain

· time domain

· de-embedding utility

· measuring output power at the 1 dB gain compression point 

· measuring AM to PM conversion

· measuring frequency mixer characteristics (PicoVNA 108 only)

· measuring phase and amplitude alignment of two external signal sources (PicoVNA 108 only)
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Front panel of the PicoVNA 106 (PicoVNA 108 is similar)

Back panel of the PicoVNA 106 (PicoVNA 108 is similar)
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SOLT-STD-M/F and SOLT-PREM-M/F manual calibration standards

SOLT-AUTO-M/F automatic (E-Cal) calibration standards
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4 Vector network analyzer basics

4.1 Introduction
A vector network analyzer is used to measure the performance of circuits or networks such as amplifiers,
filters, attenuators, cables and antennas. It does this by applying a test signal to the network to be tested,
measuring the reflected and transmitted signals and comparing them to the test signal. The vector
network analyzer measures both the magnitude and phase of these signals.

4.2 Structure of the VNA
The VNA consists of a tunable RF source, the output of which is split into two paths. The signal feeds to
the couplers are each measured by their respective reference receivers through power dividers. In the
forward mode, the test signal is passed through a directional coupler or directional bridge before being
applied to the DUT. The directional output of the coupler, which selects only signals reflected from the
input of the DUT, is connected to the Port1 receiver where the signal’s magnitude and phase are
measured. The rest of the signal, the portion that is not reflected from the input, passes through the DUT
to the Port2 receiver where its magnitude and phase are measured. The measurements at the Port1 and
Port2 receivers are referenced to the measurements made by the Ref1 and Ref2 receivers so that any
variations due to the source are removed. The Ref1 and Ref2 receivers also provide a reference for the
measurement of phase.

Simplified vector network analyzer block diagram

In reverse mode, the test signal is applied to the output of the DUT, and the Port2 receiver is used to
measure the reflection from the output port of the DUT while the Port1 receiver measures the reverse
transmission through the DUT.
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4.3 Measurement
Vector network analyzers have the capability to measure phase as well as magnitude. This is important
for fully characterizing a device or network either for verifying performance or for generating models for
design and simulation. Knowledge of the phase of the reflection coefficient is particularly important for
matching systems for maximum power transfer. For complex impedances the maximum power is
transferred when the load impedance is the complex conjugate of the source impedance (see figure).

Matching a load for maximum power transfer

Measurement of phase in resonators and other components is important in designing oscillators. In
feedback oscillators, oscillation occurs when the phase shift round the loop is a multiple of 360° and the
gain is unity. It is important that these loop conditions are met as close as possible to the center
frequency of the resonant element to ensure stable oscillation and good phase noise performance.

The ability to measure phase is also important for determining phase distortion in a network. Phase
distortion can be important in both analog and digital systems. In digital transmission systems, where the
constellation depends on both amplitude and phase, any distortion of phase can have serious effects on
the errors detected.

4.4 S-parameters
The basic measurements made by the vector network analyzer are S (scattering) parameters. Other
parameters such as H, Y, T and Z parameters may all be deduced from the S-parameters if required. The
reason for measuring S-parameters is that they are made under conditions that are easy to produce at RF.
Other parameters require the measurement of currents and voltages, which is difficult at high
frequencies. They may also require open circuits or short circuits that can be difficult to achieve at high
frequencies, and may also be damaging to the device under test or may cause oscillation.

Forward S-parameters are determined by measuring the magnitude and phase of the incident, reflected
and transmitted signals with the output terminated with a load that is equal to the characteristic
impedance of the test system (see figure below).
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S-parameter definitions
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The measured parameters are presented in a file similar to the one below. The format is as follows:

· Header lines: these start with a ! symbol and give general information such as time and date. 

· Format line: this starts with a # symbol and gives information about the format of the data. 
o First field gives the frequency units, in this case MHz
o Second field indicates the parameters measured, in this case S-parameters

o Third field indicates the format of the measurement, in this case MA meaning magnitude and angle.

Others formats are RI, meaning real and imaginary, and DB, meaning log magnitude and angle.

· Data lines. The number of columns of data depends on the parameters that have been measured. 
o A 1-port measurement measures the reflected signal from the device under test and usually produces

three columns. If the format is MA (magnitude and angle), the first column is the measurement
frequency, the second is the magnitude of S11 and the third is the angle of S11. If the format is RI, the

second column is the real part of S11 and the third column is the imaginary part of S11. 

o When a reflection and transmission measurement is made there are five columns of data. Column 1
is the measurement frequency, columns 2 and 3 contain S11 magnitude and angle or real and

imaginary data, and columns 4 and 5 contain S21 magnitude and angle or real and imaginary data.  

o If a full 2-port measurement is made, there will be nine columns of data. Column 1 contains
frequency information, columns 2 and 3 S11 data, 4 and 5 S21 data, 6 and 7 S12 data, and 8 and 9 S22

data.
The PicoVNA 106 and 108 can generate full set of 2-port parameters but you can choose to export either

1-port .s1p or full 2-port .s2p S-parameter files to suit most RF and microwave circuit simulators.
Part of a typical 2-port S-parameter file is shown below. The header shows that the frequency units are
MHz, the data format is Magnitude and Angle and the system impedance is 50 Ω. Column 1 shows
frequency, 2 and 3 S11, 4 and 5 S21, 6 and 7 S12, and 8 and 9 S22.

! 06/09/2005  15:47:34

! Ref Plane: 0.000 mm

# MHZ S MA R 50

!

3        0.00776   16.96   0.99337    -3.56  0.99324    -3.53  0.00768    12.97

17.985   0.01447   19.99   0.9892    -20.80  0.98985   -20.72  0.01519    15.23

32.97    0.01595   20.45   0.98614   -37.96  0.98657   -37.95  0.01704     6.40

47.955   0.01955   28.95   0.98309   -55.15  0.98337   -55.10  0.018       1.75

62.94    0.02775   24.98   0.98058   -72.29  0.98096   -72.29  0.0199     -6.07

77.925   0.03666   11.76   0.97874   -89.46  0.9803    -89.45  0.02169   -23.06

92.91    0.04159   -6.32   0.97748  -106.62  0.9786   -106.62  0.01981   -48.43

107.895  0.0426   -24.79   0.97492  -123.77  0.97579  -123.89  0.01424   -87.79

122.88   0.0396   -41.35   0.97265  -141.25  0.97269  -141.30  0.00997  -166.81

137.865  0.03451  -52.96   0.96988  -158.65  0.96994  -158.76  0.01877   113.15

152.85   0.03134  -56.07   0.96825  -176.27  0.96858  -176.28  0.03353    69.81

167.835  0.03451  -57.72   0.96686   166.10  0.96612   165.99  0.04901    34.83

182.82   0.04435  -67.59   0.9639    148.18  0.96361   148.21  0.06131     1.42

197.805  0.05636  -86.28   0.96186   130.15  0.96153   130.06  0.07102   -33.33

212.79   0.06878  -110.45  0.95978   111.82  0.95996   111.90  0.07736   -69.57

227.775  0.08035  -136.14  0.9557     93.50  0.9568     93.41  0.08303  -107.21

242.76   0.09099  -161.24  0.95229    74.84  0.95274    74.89  0.08943  -144.34

257.745  0.10183   175.34  0.94707    56.03  0.94755    55.95  0.09906  -179.63
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4.5 Displaying measurements
Input and output parameters, S11 and S22, are often displayed on a polar plot or a Smith chart. The polar

plot shows the result in terms of the complex reflection coefficient, but impedance cannot be directly
read off the chart. The Smith chart maps the complex impedance plane onto a polar plot. All values of
reactance and all positive values of resistance, from 0 to ∞, fall within the outer circle. This has the
advantage that impedance values can be read directly from the chart.

The Smith chart
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4.6 Calibration and error correction
Before accurate measurements can be made, the network analyzer needs to be calibrated. In the
calibration process, well-defined standards are measured and the results of these measurements are
used to correct for imperfections in the hardware. The most common calibration method, SOLT (short,
open, load, thru), uses four known standards: a short circuit, an open circuit, a load matched to the system
impedance, and a through line. These standards are usually contained in a calibration kit and their
characteristics are stored on the controlling PC in a Cal Kit definition file. Analyzers such as the PicoVNA
106 and 108 that have a full S-parameter test set can measure and correct all 12 systematic error terms.

Six key sources of errors in forward measurement. 
Another six sources exist in the reverse measurement (not shown).
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4.7 Other measurements
S-parameters are the fundamental measurement performed by the network analyzer, but many other
parameters may be derived from these including H, Y and Z parameters.

4.7.1 Reflection parameters

The input reflection coefficient Γ can be obtained directly from S11:

 

ρ is the magnitude of the reflection coefficient i.e. the magnitude of S11:

ρ = |S11|

 Sometimes ρ is expressed in logarithmic terms as return loss:

return loss = –20 log(ρ)

VSWR can also be derived:

VSWR definition
 

4.7.2 Transmission parameters

Transmission coefficient T is defined as the transmitted voltage divided by the incident voltage. This is
the same as S21.

If T is less than 1, there is loss in the DUT, which is usually referred to as insertion loss and expressed in
decibels. A negative sign is included in the equation so that the insertion loss is quoted as a positive
value:
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If T is greater than 1, the DUT has gain, which is also normally expressed in decibels:

  

4.7.3 Phase

The phase behavior of networks can be very important, especially in digital transmission systems. The
raw phase measurement is not always easy to interpret as it has a linear phase increment superimposed
on it due to the electrical length of the DUT. Using the reference plane function the electrical length of the
DUT can be removed leaving the residual phase characteristics of the device.

Operation on phase data to yield underlying characteristics

4.7.4 Group delay

Another useful measurement of phase is group delay. Group delay is a measure of the time it takes a
signal to pass through a network versus frequency. It is calculated by differentiating the phase response
of the device with respect to frequency, i.e. the rate of change of phase with frequency:

The linear portion of phase is converted to a constant value typically, though not always, representing the
average time for a signal to transit the device. Differences from the constant value represent deviations
from linear phase. Variations in group delay will cause phase distortion as a signal passes through the
circuit.

When measuring group delay the aperture must be specified. Aperture is the frequency step size used in
the differentiation. A small aperture will give more resolution but the displayed trace will be noisy. A
larger aperture effectively averages the noise but reduces the resolution.
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4.7.5 Gain compression

The 1 dB gain compression point of amplifiers and other active devices can be measured using the power
sweep. The small signal gain of the amplifier is determined at low input power, then the power is
increased and the point at which the gain has fallen by 1 dB is noted.

The 1 dB gain compression is often used to quote output power capability.  

4.7.6 AM to PM conversion

Another parameter that can be measured with the VNA is AM to PM conversion. This is a form of signal
distortion where fluctuations in the amplitude of a signal produce corresponding fluctuations in the phase
of the signal. This type of distortion can have serious effects in digital modulation schemes where both
amplitude and phase accuracy are important. Errors in either phase or amplitude cause errors in the
constellation diagram.

4.7.7 Time domain reflectometry (TDR)

Time domain reflectometry is a useful technique for measuring the impedance of transmission lines and
for determining the position of any discontinuities due to connectors or damage. The network analyzer
can determine the time domain response to a step input from a broad band frequency sweep at
harmonically related frequencies. An inverse Fourier Transform is performed on the reflected frequency
data (S11) to give the impulse response in the time domain. The impulse response is then integrated to

give the step response. Reflected components of the step excitation show the type of discontinuity and
the distance from the calibration plane.

A similar technique is used to derive a TDT (Time Domain Transmission) signal from the transmitted
signal data (S21). This can be used to measure the rise time of amplifiers, filters and other networks. The

following provides a more detailed treatment of TDR and TDT.
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4.7.7.1 Traditional TDR

The traditional TDR consists of a step source and sampling oscilloscope (see figure below). A step
signal is generated and applied to a load. Depending on the value of the load, some of the signal may be
reflected back to the source. The signals are measured in the time domain by the sampling scope. By
measuring the ratio of the input voltage to the reflected voltage, the impedance of the load can be
determined. Also, by observing the position in time when the reflections arrive, it is possible to determine
the distance to impedance discontinuities.

Traditional TDR setup

4.7.7.1.1 Example: shorted 50 ohm transmission line

 

Simplified representation of the response of a shorted line.



Vector network analyzer basics

23Copyright © 2017–2022 Pico Technology Ltdpvug-7

PicoVNA 6 and 8.5 GHz Vector Network Analyzers

For a transmission line with a short circuit (figure above) the incident signal sees the characteristic
impedance of the line so the scope measures Ei. The incident signal travels along the line to the short
circuit where it is reflected back 180° out of phase. This reflected wave travels back along the line
canceling out the incident wave until it is terminated by the impedance of the source. When the reflected
signal reaches the scope the signal measured by the scope goes to zero as the incident wave has been
canceled by the reflection. The result measured by the scope is a pulse of magnitude Ei and duration that
corresponds to the time it takes the signal to pass down the line to the short and back again. If the
velocity of the signal is known, the length of the line can be calculated:

where v is the velocity of the signal in the transmission line, t is the measured pulse width and d is the
length of the transmission line.

4.7.7.1.2 Example: open-circuited 50 ohm transmission line

Simplified representation of the response of a open line

In the case of the open circuit transmission line (figure above) the reflected signal is in phase with the
incident signal, so the reflected signal combines with the incident signal to produce an output at the
scope that is twice the incident signal. Again, the distance d can be calculated if the velocity of the signal
is known.
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4.7.7.1.3 Example: resistively terminated 50 ohm transmission line

Simplified representation of the response of a resistively terminated line

4.7.7.1.4 Reactive terminations and discontinuities

Reactive elements can also be determined by their response. Inductive terminations produce a positive
pulse. Capacitive terminations produce a negative pulse.

 

Simplified representation of the response of a reactively terminated line

Similarly, the position and type of discontinuity in a cable, due to connectors or damage, can be
determined. A positive pulse indicates a connector that is inductive or damage to a cable, such as a
removal of part of the outer screen. A negative-going pulse indicates a connector with too much
capacitance or damage to the cable, such as being crushed.

Simplified representation of the response of a line discontinuity
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4.7.7.2 Time domain from frequency domain

An alternative to traditional TDR is where the time domain response is determined from the frequency
domain using an Inverse Fast Fourier Transform (IFFT). Several methods are available for extracting time
domain information from the frequency domain. The main methods are lowpass and bandpass.

4.7.7.2.1 Lowpass method

The lowpass method can produce results that are similar to the traditional TDR measurements made with
a time domain reflectometer using a step signal, and can also compute the response to an impulse. It
provides both magnitude and phase information and gives the best time resolution. However, it requires
that the circuit is DC-coupled. This is the method supported by the PicoVNA 106 and 108.

The lowpass method uses an Inverse Fourier Transform to determine the impulse response in the time
domain from the reflection coefficient measured in the frequency domain. The DC component is
extrapolated from the low-frequency data to provide a phase reference. Alternatively, if the DC termination
is known it can be entered manually. Once the impulse response is computed, the step response may be
determined from the time integral of the impulse response. In the step response mode the trace is similar
to that of a TDR, except that there is no step at t = 0. When the time domain response is derived from the
frequency information the value at t = 0 is the impedance of the transmission line or load immediately
following the calibration plane. The value is referenced to 50 Ω, the characteristic impedance of the
system. For example, an open circuit would appear as a value of +1 unit relative to the reference value
and a short circuit would appear as a value of –1 unit relative to the reference value (see example TDR
plots above).

To facilitate the use of the Inverse Fourier Transform to compute the time domain response, the samples

in the frequency domain must be harmonically related and consist of 2n points. For this reason, the TDR
facility in the PicoVNA 106 and 108 makes available special 512, 1024, 2048 and 4096-frequency-point
calibrations with a stop frequency of up to 6000 MHz (PicoVNA 106) or 8500 MHz (PicoVNA 108). The
resulting alias-free range is a function of the number of frequency points (N) and the total frequency span.
It is given by the expression:

So, the available ranges on the PicoVNA units are approximately as follows:

Model PicoVNA 106 PicoVNA 108

Ranges 85 ns, 171 ns, 341 ns, 683 ns 60 ns, 120 ns, 240 ns, 481 ns

Time resolution 98 ps to 84 ps 58 ps

The transform returns twice the number of points of the calibration in the time domain. Therefore the
above ranges provide time resolutions  approximately as shown.

4.7.7.2.2 Bandpass method

The bandpass method provides only magnitude information so it is not possible to distinguish between
inductive and capacitive reactances. Also, the time resolution is only half as good as in the lowpass
mode. However, the method can be used for circuits where there is no DC path and hence is suitable for
AC-coupled circuits such as bandpass filters. This method is not currently supported by the PicoVNA 106
and 108.
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4.7.7.3 Windowing

The bandwidth of the network analyzer is limited by the frequency range, so the frequency domain data
will be truncated at the bandwidth of the analyzer. Also the analyzer gathers data at discrete frequencies.
The result of the sampled nature of the data and the truncation in the frequency domain is to produce a
sin(x)/x response when transformed to the time domain. This appears as ringing on both the displayed
impulse response and the step response. To overcome this problem, a technique known as windowing
can be applied to the frequency domain data before implementing the Inverse Fourier Transform. 

The windowing function progressively reduces the data values to zero as the edge of the frequency band
is approached, thus minimizing the effect of the discontinuities. When the modified data is transformed,
the ringing is reduced or removed depending on the selected windowing function. However, the windowing
function reduces the bandwidth and so increases the width of the pulse in impulse response mode and
slows the edge in step response mode. A balance must be made between the width of the pulse, or speed
of the edge, and the amount of ringing to be able to determine closely spaced discontinuities. The
PicoVNA 106 and 108 allow you to choose a rectangular window (no bandwidth reduction), a Hanning
window (raised cosine), or a Kaiser–Bessel window. The order of the Kaiser–Bessel window is
configurable.

4.7.7.4 Aliasing

The sampled nature of the data means it is subject to the effects of aliasing. The result is repetition of
time-domain response at the effective sampling rate in the frequency domain. This limits the maximum
time delay and hence maximum cable length that can be observed. In the PicoVNA 106 this is 683 ns
(approximately 138 m of cable) and in the PicoVNA 108 it is 481 ns (approximately 97 m of cable).
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5 Getting started
Refer to the Quick Start Guide above for initial instructions, then return here for more detail.

5.1 Minimum requirements
A PC or laptop is required to operate the VNA. The recommended minimum requirements are stated in
the Specifications.

The performance of the software is influenced by the performance of the PC and video adaptor installed
in it. It is important that an adaptor with good graphics performance is used. As a general guide, it is
recommended that an adaptor with at least 64 MB of memory is used.

5.2 Software installation
Follow the Quick Start Guide to install the software from the disk or from www.picotech.com. The
installer will copy the program and the USB driver to your computer. You need administrative privileges in
order to run the installer.

The installer creates a support directory at one of these locations:

· PicoVNA 106: C:\User\Public\Documents\PicoVNA2

· PicoVNA 108: C:\User\Public\Documents\PicoVNA3

This directory contains the following files:

· xxx-log.txt The status log file. ‘xxx’ is the serial number

· DefCal.cal Default calibration data (last used calibration)

· UsersGuide.pdf This User's Guide

· Support\ Folder with data files to support the software

5.2.1 Typical error messages

On Windows 7 machines it is common to see the following error message:

It is safe to click Ignore to continue the installation.
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5.2.2 Mixer measurements (PicoVNA 108 only)

Control of the PicoSource AS108 300 kHz to 8 GHz signal source is built into the PicoVNA software. If
you wish to carry out mixer measurements using other sources or sensors it is very likely that you will

need to install the Keysight® IO Libraries Suite to support communication with external instruments
through either the USB or GPIB interfaces. Please see www.keysight.com for details.

http://www.keysight.com
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5.3 Switching on the VNA
When the VNA is powered on, the front-panel channel activity indicators will flash to indicate that the
controller has started correctly.

5.4 Calibration kit parameters
The minimum requirements to carry out a 12-term calibration (full error correction) depend on the device
to be tested. For example, the most accurate calibration is for insertable devices, and this requires a total
of six standards: three of the four in each of the male and female cal standards. 

An ‘insertable’ device is one that has connectors of different sexes at its ports. On the other hand, a
calibration for a non-insertable device can be carried out using only three standards by using the unknown
thru calibration method.

The calibration kits parameters can be inspected using the Calibration Kit Parameters window (see
below) found under the Tools menu. From this the kit editor can be launched to modify and create new
kits as discussed later in the section.

The unknown thru calibration method only requires that the thru adaptor be reciprocal: that is, have S21 =

S12.

Calibration kit window. The short/open offsets are in mm in air.

5.4.1 Manual fixed SOLT calibration - insertable DUT

Two Pico calibration kits required: Premium PC3.5 kits SOLT-PREM-M and SOLT-PREM-F or Standard
SMA kits SOLT-STD-M and SOLT-STD-F or alternative calibration kits comprising:

· Open circuit (2 pieces, one male and one female)

· Short circuit (2 pieces, one male and one female)

· Matched termination (2 pieces, one male and one female)
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For insertable DUTs the requirement is for two calibration kits, one of each sex. Generally, it is required
that the matched termination should be of good quality and, as a guide, should have a return loss of
better than 40 dB. However, the PicoVNA 106 and 108 allow terminations with relatively poor return loss
values to be used and still maintain good accuracy. This is discussed in Using a matched termination.

5.4.2 Manual fixed SOLT calibration - non-insertable DUT

One Pico calibration kit required: Premium PC3.5 kit SOLT-PREM-M or SOLT-PREM-F or Standard SMA kits

SOLT-STD-M or SOLT-STD-for alternative calibration kit comprising:

· Open circuit (1 piece)

· Short circuit (1 piece)

· Matched termination (1 piece)

· Either a characterized through connection adaptor (1 piece) or any uncharacterized reciprocal adaptor

For non-insertable DUTs only a single calibration kit is required. In addition, a reciprocal but otherwise
unknown thru adaptor, or a fully characterized thru adaptor, is required. The latter is supplied with all Pico
standard kits.

5.4.3 Open circuit model

The open circuit capacitance model used is described by the equation below, where F is the operating
frequency. Generally, with typical open circuit standards, the effect is small, amounting to no more than a
few degrees of phase shift at 6 or 8.5 GHz.

Copen = C0 + C1F + C2F2 + C3F3

In addition, an offset length (sometimes referred to as offset delay) can be entered as well as the loss of
the offset line.

5.4.4 Short circuit model

The short circuit inductance is modeled by an inductance component and in addition, a non-zero offset
length can be entered together with the loss of the offset line.

5.4.5 Short and open without models

The PicoVNA 106 and 108 support short and open standards defined by data only. In this case the data is
supplied in the form of a 201-frequency-points table. Each frequency point has three comma-separated
entries: frequency (in MHz), real part of the reflection coefficient and the imaginary part of the reflection
coefficient.

5.4.6 Calibration kit editor

As already mentioned, the calibration kit editor can be used to create or edit an existing calibration kit.
The figure below shows the editor window. A typical example is to create a new kit using an existing kit
as a template to speed the process. So, the process would be to first load the existing calibration kit
from the Calibration Kit Parameters window. Type the new kit name in the name box and modify the
parameters as needed. Finally, click Save Kit to save the new kit with a new name.
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In the above example, if the existing kit loaded had load data or through data and you want to replace this
with new data, uncheck the appropriate box and then check it again.

Calibration kit editor

The calibration kits optionally supplied with the PicoVNA 106 and 108 provide an economical solution
while retaining good measurement accuracy. They are supplied with SMA or precision PC3.5 (SMA-
compatible) connectors. Refer to the PicoVNA 100 Series Data Sheet for details.

5.4.7 Using a matched termination with poor return loss or
unmodeled short and open

A successful calibration can be carried out without the need for a good-quality matched load. In order to
retain accuracy, it is necessary to provide the instrument with accurate performance data of the matched
load to be used. The data needs to be in a fixed format thus:

Frequency (MHz) S11 (real) S11 (imaginary)

   
1.0 -1.7265E-03 7.7777E-05 There must be 201 data lines. Typically these

should cover the band 0.3 MHz to (6.00 GHz or
8.50 GHz). No empty or comment lines are
allowed.

30.995 -1.6588E-03 3.3093E-04

60.99 -1.4761E-03 5.9003E-04

90.985 -1.4653E-03 1.0253E-03

120.98 -1.3841E-03 1.2608E-03

150.975 -1.1924E-03 1.5800E-03

240.96 -1.0884E-03 1.9085E-03

300.95 -8.7216E-04 2.1355E-03

330.945 -7.0326E-04 2.4109E-03

360.94 -5.7006E-04 2.6790E-03

Format for characteristics of matched load

In the case when the models for the open and short are not known, it is possible to enter measured data
in the same format as shown above. This approach can give good results if the open and short can be
measured accurately, particularly at the higher frequencies where it is usually difficult to model
components accurately.
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When supplied, the data for the through connection adaptor must be in the format shown below. The data
must be a full set of S-parameters with no empty or comment lines. It is important that the data spans as
much of the full frequency range as possible, for example from 0.3 MHz to (6000 MHz or 8500 MHz).

Freq (MHz) S11r S11i S21r S21i S12r S12i S22r S22i
0.3 1.1450E-04 -1.0852E-04 0.9965E-01 -1.0394E-03 9.9947E-01 -7.4717E-04 1.0723E-04 4.9711E-05

40.3 2.9307E-04 1.9923E-04 9.9973E-01 -1.0241E-02 9.9934E-01 -1.0505E-02 2.0715E-04 2.0814E-04

80.3 4.1774E-04 4.3168E-04 9.9922E-01 -1.9672E-02 9.9927E-01 -1.9668E-02 2.8195E-04 2.8897E-04

120.3 5.3415E-04 5.7609E-04 9.9898E-01 -2.9165E-02 9.9855E-01 -2.8852E-02 4.0525E-04 2.8043E-04

160.3 7.1924E-04 6.4942E-04 9.9883E-01 -2.9165E-02 9.9855E-01 -2.8852E-02 4.0646E-04 2.8133E-04

200.3 7.8941E-04 7.5903E-04 9.9834E-01 -3.8214E-02 9.9846E-01 -3.8128E-02 5.4323E-04 2.2344E-04

240.3 9.9069E-04 7.8162E-04 9.9792E-01 -5.7033E-02 9.9758E-01 -4.7805E-02 5.7273E-04 2.9411E-04

280.3 1.0791E-03 8.0397E-04 9.9715E-01 -6.6419E-02 9.9699E-01 -6.5967E-02 5.7191E-04 2.6551E-04

320.3 1.2779E-03 8.5429E-04 9.9648E-01 -7.5557E-02 9.9625E-01 -7.5449E-02 6.3081E-04 2.9580E-04

...

and so on, to a total of 201 frequency points

Format for the characteristics of the through connector. These must be a full set of S-parameters (real
and imaginary).

To add matched load, short and open, or thru adaptor data to a calibration kit, follow the steps below:

· Load kit using the Kit Editor (see Calibration Kit)

· Check the Load Data Available box and similarly the boxes for the Thru and Short and Open circuits in
the Kit Editor parameters window.

· If the existing kit already has load, short and open, or through data, uncheck and recheck the
appropriate box. If this is not done, the existing data will be kept and copied to the new kit.

· If needed, manually enter the rest of the kit parameters. Ensure that the correct offset is entered.

· Click Save Kit 

· When prompted, select the data file containing the matched load or the thru adaptor data in the format
shown above.

· Save the kit for future use by clicking the Save Kit button (see Calibration Kit).

Note: When a kit is loaded, any available matched load or thru adaptor data that is associated with the kit
will be automatically loaded.

The calibration kits available for the PicoVNA 106 and 108 come complete with matched load, short and
open, and thru adaptor data. Copy these files to your computer for easy access. 

It is critically important that the correct kit data, with the correct serial number, is loaded.

5.4.8 Using a third-party calibration kit

The PicoVNA 106 and 108 may be used with third-party calibration kits, such as the Keysight/Agilent
85032F, that are characterized by polynomial coefficient models either in written form or as a text file.

1. Use the PicoVNA cal kit editor (Tools > Calibration Kit > Cal Kit Editor).

2. Uncheck all the "data available" boxes.

3. Enter the four poly coefficients of Open capacitance.

4. Enter only the L0 poly coefficient of Short inductance (neglecting the small and HF dominating
coefficients)

5. Enter the Short and Open Loss terms.

6. Convert Short and Open offset times (ps) to distance (mm) in air and enter those.
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7. The short and open Z0 values are not used (assumed 50 Ω).

8. Nothing is entered for the Load.

9. As this Cal Kit does not have a Thru, we have left the length as zero.  If a Thru is provided, measure the
length (reference plane to reference plane in mm) and enter that to recreate these files.

10. Save the cal kit file(s) generated by the editor. We suggest including the calibration kit model number,
and serial number if provided, in the file name.

5.4.9 Defining and Using TRL/TRM Calibration Standards

Below is a summary explanation of preparation for a TRL/TRM calibration.  Further detail can be gained
from the white paper entitled TRL calibration for SMT devices using the PicoVNA 108.

Higher Frequencies - Reference line length
For the TRL calibration of higher frequencies it is generally recommended that the line length, ΔL, is
selected to provide no less than 20º and no more than 160º of phase shift with respect to the thru length
over the band of operation. In practice, best results are achieved by restricting the range to around 30º to
150º.
The required reference line length can be calculated as follows.

Φ = phase shift in degrees
f = frequency
c = speed of light
εeff = effective dielectric constant

It is sensible to avoid lower microwave frequencies in order to avoid skin depth effects. So, keeping to
1.5 or 2 GHz and above may be a good idea.

Note: The absolute value of L is not important. 
However, all L/2 sections shown must be identical and be exactly half the value of L.

https://www.picotech.com/vector-network-analyzer/picovna/picovna-documents
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PCB circuit blocks for TRL calibration and measurement

For example, assuming a nominal 50 Ω line with resulting effective dielectric constant of 3.35, to achieve
30º phase shift at, say, 1.5 GHz, we find that:
∆L = 9.1 mm
This reference line length of 9.1 mm would in turn provide 150º of phase shift at 7.5 GHz.  So, the useable
bandwidth for this line, as a TRL line standard, is 1.5 GHz to 7.5 GHz.

Lower frequencies - Matched Loads for TRM calibration
The PicoVNA 108 automatically switches to TRM at frequencies below those supported by the TRL
reference line(s). The TRM technique relies on matched loads to set the reference impedance. This
approach works well since good matched loads can easily be implemented at lower microwave
frequencies (< 2 GHz). The frequency range of the TRL reference line is set in the calibration kit definition
and is described in the following section.

TRL calibration kit
In order to perform a TRL calibration with the PicoVNA, a calibration kit file needs to be created. This can
be done very easily using the calibration kit editor (Tools > Calibration kit > Cal Kit Editor).
 

Use the calibration kit editor to create the TRL cal kit file

TRL calibration kit – entering the reference line information
In this example we will use only one of the possible reference lines  (‘Delays’) so we check just the box
next to ‘Line 1’ to indicate that the cal kit has only one reference line. The Line 2 box is left unchecked as
shown above.
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We can either enter the electrical delay in ps and click the button Compute from delay to set the
frequency range of the line, or preferably, enter directly a narrower frequency range we wish to assign to
the reference line. The low frequency is entered into the box labeled FL and the high frequency into the
box FH. Both values are in GHz. 

TRL calibration kit – entering the Reflect Standard information
The next step is to select whether the Reflect Standard is going to be a short or an open circuit. Click the
appropriate radio button as required. Note that it is only necessary to know approximately the value of
the reflection coefficient of the Reflect Standard. So, for example we could use on-PCB short circuits
implemented with vias to ground. For this, we can enter 100 pH as an approximate value of the inductance
into the box labeled L (pH).  Alternatively a more accurate value might be available from design CAD or
direct measurement.

Likewise if we chose to use Open reflection standards we would enter a capacitance value at C0.

Finally, we enter the desired Kit name in the top left box and click Save Kit to save the file to disk.  We
would recommend indication of this being a TRL Kit with Open/Short reflect standards and possibly its
Max frequency coverage within the file name.
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6 Operation
The PicoVNA 3 software allows you to program the measurement parameters and plot the measurement
results in real time. The main window includes a status panel that displays information including
calibration status, frequency sweep step size and sweep status. The Help menu includes a copy of this
manual.

6.1 The PicoVNA 3 main window
The PicoVNA 3 main window is shown below. It is dominated by a large graphics area where the
measurement results are plotted together with the readout of the markers. One, two or four plots can be
displayed simultaneously. The plots can be configured to display the desired measurements.

User interface window
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6.1.1 Display setup

Setting up the display is carried out through the Display Set Up window which is called up from the main
window by clicking Display. The window is shown below. The typical sequence to set up the display is as
follows:

· Set the number of channels to be displayed by clicking the appropriate radio button under Display
Channels

· Select the desired active channel from the drop-down list (can also be selected by clicking on a marker
in the main window on the desired display channel)

· Select the channel to set up by clicking the appropriate radio button under Select

· Choose the desired parameter to display on this channel from the drop-down list under Parameter /
Graph Type

· Choose the desired graph type from the drop-down list under Parameter / Graph Type

· Select the vertical axis values from the Vertical Axis section. Optionally, click Autoscale to
automatically set the sensitivity and reference values. Note that reference position 1 is at the top (see
second figure below).

· Click Apply to apply the selected values

· Repeat the above steps for each display needed

Note: The Active Channel must be one of the displayed channels.

The Display Set Up window is used to set up the measurements display

· When finished, click Start in the main window to begin measurements
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Display graph parameters

The colors of the main graphics display can be changed to suit individual preferences. This can be done
by selecting the Color Scheme item from the Tools menu. To set a color, click the color preview box next
to the item name.

Once you have set up a color scheme, you can save and recall it as a Cal and Status or just a Status
setting using the File menu.

Editing graph parameters using the mouse

The figure above shows how the mouse can be used to quickly adjust reference position, reference value
and vertical scale sensitivity for the graph. Hover the mouse pointer over the number, or the reference
position triangle, then click and drag to adjust the indicated values up and down. To type the values for
reference value and vertical scale, hover the mouse over the number, right-click and type. To save the
value, press enter or left-click.
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6.1.2 Data markers

It is possible to display up to eight markers on each display. They are set up by clicking on the Markers
button (see figure below). There are four possible marker modes as follows:

Active marker: The active marker is the marker used for comparison when the delta marker mode
(switched on by selecting a reference marker) is on. One of the displayed markers must be chosen as the
active marker.

Reference marker: The reference marker causes the delta marker mode to be switched on. The value
difference between the active marker and the reference markers is shown on the right hand marker
display panel.

Fixed marker: A fixed marker cannot be moved and its position is not updated with subsequent
measurement values. It provide a fixed reference point. Only a reference marker can be made a fixed
marker. Once a marker is fixed, it cannot be moved until it is unfixed.

Normal marker: The value of a normal marker is displayed on the right-hand marker readout panel and in
lower resolution readouts below each measurement plot.

Any marker (except a fixed marker) can be moved to a new position by left clicking on it (on any displayed
channel) and dragging it to a new position.

The markers set up form provides a Peak / Minimum Search facility.  This places marker 1 at either the
peak or minimum value on the displayed trace on the active channel when the corresponding Find button
is pressed.

The Markers Set Up dialog is used to display measurement markers
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Change the marker type by right-clicking on any marker on the active channel. Note that only the
reference marker can be fixed.

The peak / minimum search facility provides a means of placing additional markers to indicate the 3 or 6
dB bandwidth. If either the 3 dB or 6 dB band box are selected, then clicking Find will place markers 2 and
3 on the frequency points either side of marker 1 which are 3 dB or 6 dB relative to it. Note that for best
accuracy a sufficient number of sweep points should be used. This will ensure a fine enough resolution to
allow accurate determination of the band points.

6.1.3 Measurement enhancement

The measurement enhancement options are displayed (see figure below) by clicking Enhancement in the
main UI window. The options available are as follows.

· Averages (1 to 255, on a point by point basis)

· Trace Smoothing (0 to 10%)

· Bandwidth (140 kHz to 10 Hz)

· Port 1 Level (+6 dBm to –20 dBm for PicoVNA 106, +10 dBm to –20 dBm for PicoVNA 108; 0.1 dB
resolution)

· CW sweep time per point (0.5 to 65 ms/point for PicoVNA 106, 0.5 to 220 ms/point for PicoVNA 108)

· Reference Plane Extension (manual entry or automatic)



Operation

41Copyright © 2017–2022 Pico Technology Ltdpvug-7

PicoVNA 6 and 8.5 GHz Vector Network Analyzers

· Effective dielectric constant of device under test (manual entry to correct plane extension values)

· De-embedding (specify embedding networks at ports 1 and or  2)

· Impedance conversion for devices that are not 50 Ω

The measurement enhancement window

The Bandwidth setting refers to the receiver bandwidth. Maximum sweep speed is achieved with the
highest (140 kHz) setting. On the other hand, the widest dynamic range (lowest noise floor) is achieved
with the lowest value, 10 Hz. Note that the bandwidth setting used during calibration determines the
maximum dynamic range achievable during measurements. So, consider this when carrying out a
calibration. For example, if you need to carry out measurement over more than, say 90 dB dynamic range,
then use a 500 Hz or less bandwidth setting when calibrating.

The Port 1 Level sets the test signal level. The default value is +3 dBm as this gives best overall
measurement accuracy. However, it may be necessary, particularly when measuring active devices (e.g.
amplifiers) to reduce the test level. For maximum dynamic range, then use the highest power setting. For
best measurement accuracy it is recommended that the calibration is carried out at the same test level
as it is intended to use for the measurement. Whenever the test level is different to that used for the
calibration, a ‘?’ will be added to the calibration status indicator on the Status Panel (Fig. 6.1)

The Reference Plane facility allows the reference plane of either measurement port to be arbitrarily
moved away from the calibration plane. The value entered applies to the measurement parameters (S11,

S21 and S12 or S22, S12 and S21) depending on whether port 1 or 2 are selected. Note the same plane value

will be used for all other measurements of the same parameters regardless if they are on the active
channel or not. Further note: S21 and S12 are affected by plane changes to either port 1 or 2.

The Auto Reference automatically moves the reference plane. It uses the measurement on trace 1 of the
active channel to calculate offset. This feature is particularly useful, for example, when measuring
microstrip devices and it is necessary to remove the effect of the connecting input and output lines. It
takes the effective dielectric constant value entered to correct the displayed value. Refer to Reference
plane extension and de-embedding for more details.
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Note: The reference plane must be at 0 mm for the Auto Ref function to work correctly. Also,
Enhancement window changes only take place when the instrument is sweeping.

The Effective Dielectric of the device under test can be entered so that the displayed Reference Plane
extension values (shown on the Enhancement Window) are corrected accordingly when the Auto Ref
button is clicked. The default value is 1.0 and the maximum value allowed is 50.0.

Note: The reference plane extension value shown in the main window on the markers display panel on
the right, is the reference plane extension as shown in the Enhancement window. 

The de-embedding facility is explained in detail in Reference plane extension and de-embedding.

The System Z0 Conversion facility allows measurements, which are always taken in 50 Ω,  to be converted

to another impedance that you select. This feature can be useful, for example, for measuring 75 Ω
devices. The value of Z0 entered must be real (purely resistive) and must be within the range of 10 Ω to

200 Ω. Whenever this facility is selected, an indicator is displayed on the top right corner of the graphics
display as shown in the second figure below. Note that when requested, impedance conversion will
performed on the live measurement and any stored memory trace.

There are two possible ways of using the System Z0 Conversion facility. For example, 75 Ω devices can be

measured using the techniques illustrated below.

Impedance matching pads can be used to measure
a connectorized device. Use external matching pads
and calibrate with a 75 Ω calibration kit.

A discrete device mounted on a 50 Ω test jig is
simpler to measure. Calibrate with a 50 Ω
calibration kit, use de-embedding to remove the test
jig and allow mathematical conversion to 75 Ω
impedance.

Possible techniques for measuring 75 Ω devices

The steps necessary for each of the two techniques illustrated in the figure above are as follows:

75 Ω device with connectors
i. Connect 50 Ω to 75 Ω impedance matching networks (e.g. matching pads) at the ends of the cables

connected to ports 1 and 2.
ii. In the Enhancement window, check the Convert System Zo box 
iii. Check External Zo match to indicate external matching networks in use
iv. Enter 75 in the Convert System Zo value box and click Apply
v. Proceed to calibrate using a 75 Ω calibration kit
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vi. Connect the DUT and start the measurement

75 Ω device mounted on 50 Ω test jig
i. In the Enhancement window, uncheck the Convert System Zo box 
ii. Calibrate at the ends of the test cables using a 50 Ω calibration kit
iii. Apply de-embedding to remove test jig effects. See Calibration kit for some suggestions.
iv. In the Enhancement window, check the Convert System Zo box 
v. Uncheck the External Zo match box (in this case mathematical impedance conversion is done by the

software)
vi. Enter 75 in the Convert System Zo value box and click Apply
vii. Connect the DUT and start the measurement

System impedance chosen is displayed on the top right corner

Note: S-parameters are interrelated, so, when using the Z0 conversion facility (and no external impedance

matching networks) without a full set of S-parameters available (e.g. only an S11 calibration) the program

will assume values for the unavailable parameters as shown in the following table. A warning will be
displayed in such cases.

S11 S12 S21 S22

10–6, j0.0 10–6, j0.0 10–6, j0.0 10–6, j0.0

Values assumed for parameters not available during Z0 conversion

6.1.4 Memory facility

The current displayed data on each channel can be stored in memory. Also, each channel can be stored
independently of all others. The Memory Set Up window is used to store the data and this window can be
displayed by clicking Memory in the main window.
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The Memory Set Up window is used to store data into memory

Select the destination Memory trace first, and then the source Data trace. This avoids an error message
resulting from the limitation that Trace 1 must route to Memory 1.

Once the data is stored, it can be displayed by clicking Display Data and Memory in the main window.

There are three vector math functions available: sum, subtraction and division. The selected function is
used when you select the Display Memory Math function on the main window.

The trace hold is used to store the maximum or minimum values on the memory trace. Trace hold is not
available when group delay is displayed.

6.1.5 Limit lines facility

The limit lines facility allows six segments to be defined for each displayed graph. By taking advantage of
the overlapping capability (see below) a maximum of 11 segments can be created The set up window,
shown below, is displayed by clicking Limit Lines in the main window.

Overlapping segments
All valid segments entered are loaded in sequence (i.e. segment 1 first) with the each segment loaded
having priority over the previous segment. This feature allows overlapping segments to be loaded. For
example, if segment 1 is specified to cover, say, 400 to 800 MHz, then a second segment can be specified
to a section of this band, for example, 500 to 600 MHz. This would result in a total of three segments—
that is, 400 to 500, 500 to 600 and 600 to 800 MHz—even though only two were specified. An example of a
complex 11-segment template is shown in the first plot below.

Alarm
An alarm facility is provided with the limit  lines. This provides audible warning during a sweep if any
measurement exceeds the limits set. A visible indication of the last measurement and measurement
channel in error is provided on the status panel where normally the calibration type is displayed. In
addition a symbol is drawn on the trace indicating the last error point detected as shown in the second
plot below. The alarm is available for all graph types except Smith plots.
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The Limit Lines Set Up allows at least six segments per graph



Operation

46Copyright © 2017–2022 Pico Technology Ltdpvug-7

PicoVNA 6 and 8.5 GHz Vector Network Analyzers

Complex Limit Lines templates are possible by overlapping segments

Limit Lines failure graphical visual indicator

6.1.6 Status panel

The status panel in the main window provides useful information as follows:

· Instrument serial number

· Calibration status (S11, S21, S11 + S21, 12 terms or U/T). A question mark indicates that the test power

has been changed from that used for calibration

· Test signal power. This is the Port 1 signal level

· Sweep status. Indicates whether instrument is sweeping

· Frequency step. Step size of sweep

· Sweep points. Number of points in programmed sweep

· Limit Lines alarm if any measurement exceed the set limits (temporarily replaces Calibration status)

· Internal instrument temperature (PicoVNA 108 only)
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6.1.7 Triggered sweep

It is possible to synchronize each measurement sweep to an external trigger. Simply click the appropriate
radio button in the main window and ensure that a trigger signal is connected to the instrument’s rear
panel Trigger terminal.

The instrument supports either positive or negative edge trigger depending on the radio button selected
on the main panel.  The input impedance is 10 kΩ.

Trigger selection radio button on main panel (PicoVNA 106)

Trigger selection radio button on main panel (PicoVNA 108)
Note that Save on Trigger works in +Ext, -Ext and Manual modes only.

 

When the Manual trigger option is selected, the instrument will wait until the Manual button is pressed
before starting a sweep.

6.1.8 Sweep trigger output

The rear panel Trigger Output terminal provides a 3 V logic output with the rising edge synchronized to
the start of the measurement sweep. The signal goes to 0 V at the end of the sweep. The output
resistance is about 500 Ω.

6.1.9 Measurement start / stop

The measurement Start / Stop buttons (see figure) are used to start or stop the instrument’s sweep mode
(measurement mode). This is necessary as functions which require reprogramming the instrument can
only take place when the instrument is idle. The instrument status is shown in the Status Panel as
described in the previous section.

The Start / Stop Measurement buttons control the sweep status

Note that when the sweep is stopped, the test signal frequency is held at the frequency point at the time
the stop command is received by the instrument. In the case of triggered sweep, by default, at the end of
the sweep, the frequency is held at the last frequency point until the next sweep trigger event is received.
This can be changed from the Tools > Diagnostics menu.
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6.1.10 PC data link interruption

The data flow between the VNA and its controlling PC can be interrupted by external factors. If the
software cannot restore the link, a message similar to this will appear:

Warning message when the link with the PC is interrupted

In such a case:

· Restart the software using the selection in the drop-down menu under Tools

· Switch the VNA off and on again (using the switch on the back) when prompted to do so

· Wait until the front panel lights have stopped flashing

· Click OK to complete the software restart

· Recalibrate the instrument

You should rarely see a ‘No Response’ message. If it happens often, check that the PC is not running
other applications and that the VNA software is not running as a background task when the sweep is on. 

6.2 Calibration
The instrument must be calibrated before any measurements can be carried out. This is done by loading a
previous calibration (see File menu) or carrying a fresh calibration by clicking Calibration in the main
window, which brings up the Calibration window as shown here:
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Note: The frequency sweep is set by entering the start, stop and selecting the number of sweep points.
Alternatively, by entering the centre frequency and span after clicking on the Centre/Span format option
box.

The table below summarizes the calibration types available together with the standards required to
complete the calibration. For best overall accuracy, particularly when measuring low isolation devices
with poor return loss values, a 12-term calibration should be performed.

Required calibration
standards

S11 S21 S11 + S21 12 terms (insertable
DUT)

12 terms or 8
terms* (non-
insertable DUT)

Fixed SOLT standards Matched load
Open
Short

Through
connection
Termination (see
text)

Matched load
Open
Short
Through
connection

Matched load (x 2)
Open ( x 2)
Short (x 2)
Through cable

Matched load (x 1)
Open ( x 1)
Short (x 1)
Thru adaptor (x 1)
Through cable

E-Cal automated SOLT
standards (PicoVNA 108
only)

E-Cal SOLT kit
only

Not supported Not supported E-Cal SOLT kit (use
supplied port
adaptor)

E-Cal SOLT kit only

TRL/TRM standards
(PicoVNA 108 only)

N/A N/A N/A 2x Feed+Short or 2x
Feed+Open,
2x Feed+Match,
Thru = 2xFeed and
Thru =
2xFeed+Delay.

N/A

Measurement capability S11 using 3-term

error correction

Frequency
response with
isolation
correction

S11 using 3-term

error correction
Frequency
response with
isolation and
source match
correction

S11, S21, S12, S22

using 12-term error
correction

S11, S21, S12, S22

using 12-term error
correction or 8-term
correction

Calibration types supported. 
* The unknown thru calibration (8 error terms) requires only a reciprocal thru adaptor.

Here is the basic calibration sequence:

Instrument calibration sequence. This loop is fully automated when using an E-Cal module.

The calibration process involves connecting each standard in turn and clicking. An asterisk will appear
once it has been measured so that the next standard can be done.

Note: For best results, ensure that the instrument is fully warmed up before carrying out a calibration.
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Calibration for measuring non-insertable devices

Insertable and non-insertable DUTs

It is important to be aware of the difference between ‘insertable’ and ‘non-insertable’ devices and the
impact on measurement and calibration technique. The figure above illustrates the difference between an
insertable device and non-insertable devices. The key issue is that with non-insertable devices an adaptor
will be required during the calibration measurement as shown. In order to obtain accurate DUT
measurement data, the effect of the adaptor needs to be removed from the measurements. Some of the
possible ways of doing this with the PicoVNA 106 and 108 are as follows:
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At calibration

Calibration used Adaptor removal method Comments

(A) 12-term (insertable DUT) N/A There is no adaptor delay, match or loss to
correct. Two fixed Short Open Load kits
(male and female) or one automated E-Cal kit
are required

(B) 12-term (non-insertable DUT) Calibration removes known
(previously measured) adaptor
characteristics

Accurate but requires kit with an s-parameter
characterized "known" thru adaptor standard.
Only one calibration kit is required

(C) 8-Term (unknown thru method) Calibration automatically removes
adaptor effect. Calibration
includes measurement of and
removal of the unknown thru
characteristics.

Accurate and easiest method as it does not
require a characterized thru standard. One
fixed Short Open Load kit required plus any
unknown adaptor, cable or line.  One
automated E-Cal kit can be used, its Thru will
be measured in this case.

At measurement: Alternatively any calibration can be performed and then one or two adaptors added to the test port(s)

to achieve connection to the DUT.  The characteristics of the adaptor(s) can then be corrected thus:

Calibration used Adaptor removal method Comments

(D) Any except 12-term or 8-term De-embedding Accurate but requires prior knowledge of

adaptor characteristics or prior

measurement of the adaptor s-parameter

characteristics

(E) Any except 12-term or 8-term Reference plane extension Quick and easy but errors due to loss of

adaptor remain, this method removes the

delay (phase) errors from each test port

but errors due to loss of the adaptor(s)

remain.  A further normalization of adaptor

loss can be achieved using an estimate of

loss at 1 GHz, the Auto Ref feature or trace

Math.  However, mismatch errors will

remain.

Techniques for dealing with non-insertable DUTs

Note that for the 8-term method, isolation calibration is done automatically by the software using
measurements taken during the short, open and load steps.

Note that only the 12-term non-insertable DUT calibration and 8-term unknown thru methods support a
non-zero length thru connection. Other calibrations (S21 or S11+S21 or full 12-term insertable DUT) require

a thru connection of zero length. In effect, this means that the calibration port terminals should be of
opposite sexes. In other words, it should be possible to connect the terminals together without the use of
an adaptor. Consequently, the DUT must be an insertable device. If this is not the case, an adaptor will be
needed during the measurement  and its effect will need to be removed by either moving the reference
plane or by using the de-embedding facility as indicated in the table above.

When performing just an S21 calibration it is possible to complete the calibration without doing the

isolation calibration. Simply click Apply Cal after performing the through calibration. The isolation
calibration corrects errors due to crosstalk (see Calibration and error correction) and should be used
when measuring insertion losses larger than about 40 dB. The terminations to use during the isolation
calibration can, as a guide, be 50 Ω loads. In some circumstances, such as when testing a highly reactive
device (e.g. filter beyond cut-off), a short or an open circuit may be more appropriate or for best results
two actual DUTs with 50 Ω loads at their unused ports.
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6.2.1 Changing the frequency sweep settings without
recalibrating

If the start or stop frequency or number of sweep points is changed when the instrument has a valid
calibration, you are given the choice to either keep or delete the existing calibration. If you choose to
keep the calibration, a new set of calibration error terms will be automatically generated by interpolation
to fit in with the new sweep parameters. In this case, a “?” is added to the calibration status bar to
indicate that operating parameters have changed from those used in calibration.

If it is required to change the frequency sweep parameters without recalibrating, then simply enter the
new values (see Set Sweep Frequency values under Calibration) and click Apply. Once the new values are
sent to the instrument, just close the window (click Close Window) to exit. Note that this process will
delete all memory traces and the display data may be invalid until a fresh measurement sweep is
performed. Note that new sweep span must lie entirely within the old sweep span.  Extrapolation of
calibration is not supported.

Take care when using interpolation, particularly at low frequencies, say below 20 MHz. For example, if
starting with a wide band sweep with large frequency steps, say 500 kHz or larger, then interpolating down
to a narrow band of, for example, 1 MHz to 10 MHz may lead to larger than expected errors.

6.2.2 Calibration steps for S11 measurements

The calibration for S11 measurements performs a three term error correction calibration. Note that if the

device to be tested has a female connector, then a female calibration kit should be used for best results.
The typical steps are as follows:

1. Select the calibration kit (Tools > Calibration kit > Load P1 kit or Electronic Cal Kit > Apply)
2. For an E-Cal Kit select the appropriate  connection diagram and then Find and Load EasyCal

data>Exit>Apply
3. Set the bandwidth and test power (Enhancement button)
4. Set the frequency range and measurement steps (Calibration button)
5. Select S11 calibration (in Calibration window)

6. Connect adaptor and test cable to port 1 of the instrument
7. An E-Cal calibration will complete application of required standards automatically.
8. Connect each standard in turn and click appropriate Standard button (in Calibration window)
9. When all 3 Standards are done click Apply (in Calibration window)
10.If desired, for later use,  save calibration (File > Save cal)
11.Connect device to be tested and click Start

Tips:

· For best linearity and dynamic range combination use a test power level of 0 dBm

· For best accuracy calibrate using the same or lower bandwidth than you intend to use for your
measurements

· You can remeasure any standard at any stage before completing the calibration. Just reconnect the
standard and click again on the appropriate Standard button before completing the calibration

6.2.3 Calibration steps for S21 measurements

The simple S21 calibration is a frequency response calibration. Sometimes it is referred to as

normalization and only corrects for response characteristics of instrument and external connections. The
typical steps are as follows:

1. Set the bandwidth and test power (Enhancement button)
2. Set the frequency range and measurement steps (Calibration button)
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3. Select S21 calibration (in Calibration window)

4. Connect adaptors and test cable 2 to port 1 of the instrument
5. Connect ends of test cable together (the ‘through’ connection) and select Through  (in Calibration

window)
6. Connect 50 Ω load to the ends of test cables (to perform the isolation step) and select Isolation  (in

Calibration window)
7. Click Apply (in Calibration window)
8. If desired, for later use, save calibration (File > save cal)
9. Connect device to be tested and click Start

Tips:

· For best dynamic range, use a test power level of +6 dBm and calibrate using the same or lower
bandwidth than you intend to use for your measurements

· For best accuracy (linearity) use a test power level of –3 dBm and calibrate using the same or lower
bandwidth than you intend to use for your measurements

Pico E-Cal kits do not support this calibration mode. Use instead an 8 or 12 term calibration as below

6.2.4 Calibration steps for S11 and S21 measurements

The S11 + S21 calibration provides three term error correction for S11 measurements and Source match

correction for S21 measurements.  The typical steps are as follows:

1. Select the calibration kit (Tools > Calibration kit > Load P1 kit > Apply)
2. Set the bandwidth and test power (Enhancement button)
3. Set the frequency range and measurement steps (Calibration button)
4. Select S11 + S21 calibration (in Calibration window)

5. Connect each standard (short, open and load) in turn and click appropriate Standard button  (in
Calibration window)

6. Connect ends of test cables together and click Through
7. Connect 50 Ω load to the ends of test cables (to perform the isolation step) and select Isolation  (in

Calibration window)
8. Click Apply (in Calibration window)
9. If desired, for later use, save calibration (File > Save Cal)
10.Connect device to be tested and click Start

Tips:

· For best linearity and dynamic range combination, use a test power level of 0 dBm

· For best dynamic range  use a test power level of +6 dBm and calibrate using the same of lower
bandwidth than you intend to use for your measurements – particularly at the isolation calibration
step

Pico E-Cal kits do not support this calibration mode. Use instead an 8 or 12 term calibration as below

6.2.5 Calibration steps for all S-parameters measurements
(insertable DUT)

This calibration provides full error correction for all S-parameters. Typical steps are as follows:

1. Select the calibration kits (Tools > Calibration kits > Load P1 Kit > Load P2 Kit or Electronic Cal Kit >
Apply)

2. For an E-Cal Kit select the appropriate  connection diagram and then Find and Load EasyCal
data>Exit>Apply

3. Set the bandwidth and test power (Enhancement button)
4. Set the frequency range and measurement steps (Calibration button)
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5. Select ’All –Insertable DUT’ calibration (in Calibration window)
6. Connect each standard (short, open and load) in turn and click appropriate Standard button (in

Calibration window)
7. Click Isolation select the first method on the left (isolation is measured with 50 Ω loads on each

calibration port which is the same as the load step in 5 above)
8. Connect ends of test cables together and click Through
9. An E-Cal calibration will complete application of required standards at 6. 7. and 8. automatically.
10.Click Apply (in Calibration window)
11.If desired, for later use, save calibration (File > Save Cal and Status)
12.Connect device to be tested and click Start

Tips:

· For best linearity and dynamic range combination use a test power level of 0 dBm. Use the same or
lower bandwidth than you will use during measurements.

· For best dynamic range  use a test power level of +6 dBm and calibrate using the same or lower
bandwidth than you intend to use for your measurements.

6.2.6 Calibration steps for all S-parameters measurements
(non-insertable DUT)

This calibration provides full error correction for all S-parameters. It requires a calibration kit with a
characterized through connection. Typical steps are as follows:

1. Select the calibration kit (Tools > Calibration kits > Load P1 Kit or Electronic Cal Kit > Apply)

2. For an E-Cal Kit select the appropriate  connection diagram and then Find and Load EasyCal data >

Exit > Apply
3. Set the bandwidth and test power (Enhancement button)
4. Set the frequency range and measurement steps (Calibration button)
5. Select All – Non-insertable DUT calibration (in Calibration window)
6. Connect each reflection standard (short/open) in turn and click appropriate Standard button (in

Calibration window)
7. Click Load to measure the Load Standard (in Calibration window)
8. Connect ends of test cables together using the characterized through included in the calibration kit

and click Through

9. An E-Cal calibration will complete application of required standards at 6. 7. and 8. automatically.
10.Click Apply (in Calibration window)
11.If desired, for later use, save calibration (File > Save Cal and Status)
12.Connect device to be tested and click Start

6.2.7 Calibration steps for all S-parameters measurements
(TRL/TRM-insertable DUT)

This calibration provides full error correction for all S-parameters. It requires a TRL/TRM calibration kit
realised as 2x Short or 2x Open, 2x Matched Load, a Zero length Line and a known Delay length line all
placed at the end of identical feed structures. Typically these are all realised upon a test substrate (e.g.
PCB) and the Feed structure might be a substrate edge connector or launcher with common length feed
line. Further design details are given in the figure below. Typical steps are as follows:

1. Select the calibration kit (Tools > Calibration kits > Load P1 Kit > Apply).  Where the selected kit is a
TRL/TRM kit.

2. Set the bandwidth and test power (Enhancement button)
3. Set the frequency range and measurement steps (Calibration button) noting that the maximum

frequency may be limited by the defined cal kit.
4. Select All – Insertable DUT (TRL/TRM) calibration (in Calibration window)
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5. Connect each reflection standard (Line/Reflect/Through) in turn and click appropriate Standard button
(in Calibration window)

6. Click Load to measure the Load Standard (in Calibration window)
7. Click Apply (in Calibration window)
8. If desired, for later use, save calibration (File > Save Cal and Status)
9. Connect device to be tested and click Start

Note that Pico E-Cal and fixed SOLT Calibration kits are not applied during a TRM/TRL calibration.

Reference line impedance correction
It is likely, for example when using low-cost FR4 boards to carry the TRL/TRM standards that there will be
an error in the characteristic impedance of the TRL reference line. This can be measured using the TDR
facility in the PicoVNA 106 or 108. An example result, in terms of the line’s linear reflection coefficient, is
shown in the figure below.

Reference line Z0 can be determined from the reflection coefficient, measured using TDR

In order to be able to carry out a TDR measurement of the reference line, it is important to bear in mind
the available time resolution (or effective rise time) of the VNA TDR measurement. This is equivalent to
the inverse of the frequency span (stop frequency minus the start frequency) used. By selecting the
widest available span, we end up with a time resolution value of around 118 ps. Therefore, it is sensible to
ensure that the overall length of the reference line, plus the interconnecting lines to the edge connectors,
amounts to at least 2.5 x 118 ps. This will allow an unambiguous TDR impedance measurement to be
made in the figure below.

Once the impedance of the reference line has been determined as described, the value can be entered in
the Enhancement Set Up form as shown in the figure below. Once the value is entered and the box next to
the corresponding line is checked, all TRL measurements will be corrected using impedance conversion
back to the system impedance, typically 50 Ω. Note that the correction will only be applied over the
frequency range applicable to the line selected.
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TRL Measurement can be corrected using known Reference line Z0

This correction of line impedance will reduce any measurement discontinuities between the TRM low
frequency span and the higher frequency TRL line spans.  A further reduction of discontinuity may be
available from a complex impedance value for the line, perhaps derived from CAD or Math tools. You
might also choose to iterate to a reactive value through trial of small values.

6.2.8 Calibration for best dynamic range – minimizing the
effect of crosstalk

Instrument crosstalk is a limiting factor when making large dynamic range measurement. This is
particularly the case at higher frequencies, say above 4 GHz. The reason is that some of the crosstalk is
dependent on the loading at the test ports. Therefore, the isolation calibration process can only
compensate it fully when the terminations are left unchanged from those used at the isolation calibration
step.
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Enhanced isolation calibration
The PicoVNA 106 and 108 provide an enhanced isolation calibration option. This method makes
crosstalk measurements at the short, open and load calibration steps. In this way it attempts to more
closely model the effect of port termination on the internal crosstalk components of the instrument.

The enhanced isolation calibration helps to model the crosstalk more accurately

It is important to note that for best dynamic range, when using the enhanced isolation calibration method,
each of the short, open and load steps need to be made at the same or lower resolution bandwidth than
will be used for the measurement. So, for the ultimate range, each calibration step will need to be done
using 10 Hz bandwidth. This is the downside of the enhanced isolation calibration (slower overall
calibration process)  compared to traditional isolation calibration, where only the isolation step need be
taken at the lowest bandwidth setting.
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Achieving the ultimate dynamic range using conventional isolation calibration
In cases when two identical DUTs are available, the ultimate dynamic range can be achieved using a
conventional crosstalk (isolation) calibration step as shown in the figure below. In this approach the
correct termination is presented at each port during the crosstalk calibration step. In this way its effect
can be removed accurately over the entire measurement band. Note that when using this technique, only
the isolation step need be performed at the lowest resolution bandwidth. The other calibration steps can
be performed at higher bandwidth settings to speed up the process.

If two idential DUTs are available, a conventional isolation
calibration step can be carried out as shown

6.2.9 Loading and saving calibrations and status

Load and save calibrations using the File > Load Cal and Status and File > Save Cal and Status
commands.

Select the file type according to the type of data you wish to load or save:

· .cal – includes calibration and status data

· .sta – includes status data only

6.2.10 E-Cal 8.5 GHz Electronic Calibration Module - Principle of
operation

The E-Cal module is intended to be used for the calibration of the PicoVNA vector network analyzers. The
module consists of a set of calibration Standards switched in by means of high frequency electronic
switches. The figure below shows the arrangement.
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The PC host running the VNA UI software controls the E-Cal module through the USB connection
provided. With the modules connected to the VNA, the host selects each calibration Standard in turn and
records the response from the VNA. This allows calibration of the VNA to be carried out very fast and
with little intervention from the user. The calibration Standards are accurately characterized in the factory
and the results kept in memory within the E-Cal module which the host reads to compute the VNA error
terms and thereby complete the calibration.

Simplified block diagram of the E-Cal module

A refinement of the E-Cal module is the inclusion of temperature control.  Power from the USB
connection is used to raise and hold constant its internal temperature. This improves the overall stability
and accuracy of the module. Indication of the internal temperature of the module is provided by an LED
that switches from red to green to indicate that the target working temperature of the module has been
reached. The figure below shows a photograph of the module. A second option fitted with female
connectors is available.
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E-Cal module connections (male connector option)

6.2.11 E-Cal 8.5 GHz Electronic Calibration Module - Setting up
and operation

The E-Cal module can be used in three possible arrangements to support calibrations for both non-
insertable and insertable DUTs. A non-insertable DUT is a device with the same sex RF connectors;
typically female SMA connectors, for example. On the other hand, an insertable DUT is one with one
female and one male connector.

The available calibration arrangements (for the female connector version) are as follows:

Use of the E-Cal module to support insertable DUTs with female connectors
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Use of the E-Cal module to support insertable DUTs with a female
connector on port 1 and male on port 2

Use of the E-Cal module to support insertable DUTs with a male
connector on port 1 and a female connector on port 2

For the male connector version of the unit, similar connection arrangements are possible but a F-F
(female-female) adaptor is used instead, see figures above. Also, the test cable connectors’ sexes shown
in the figures above are reversed.

Selection of the calibration arrangement to be used is carried out as part of the ‘calibration kit selection’
procedure on the PicoVNA UI software. Firstly, connect the E-Cal module to the host PC and, ideally,
allow a few minutes for the indicator to turn green. Once the module is connected, the steps to load the
data from the module are shown below.
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Select Calibration Kit in Tools menu

Select the arrangement required and click on Find and load EasyCal data

Note. The module is supplied with an adaptor which is required to deal with insertable DUTs. It is
important that this adaptor is kept safe and connected correctly, with its marked end nearest the module
as shown.

Once the E-Cal module’s data has been loaded and connections made, select the Measurement required
in the Calibration form and then click on any calibration Standard button. All Standards will be
automatically measured. On completion click Apply Cal to exit the Calibration form. The VNA is now
calibrated and ready for use. 
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6.3 Measurements

6.3.1 Return loss

In order to carry out return loss measurements (S11) the VNA must be calibrated as described before,

either S11 calibration only, both S11 and S21 or 12-term. The device to be tested (DUT) is then connected to

Port 1 of the VNA as indicated in the figure below. If the DUT can only be connected to the VNA using a
cable, then the VNA should be calibrated at the end of the cable for best results.

Connect device under test to Port 1 to carry out S11
measurements. 

Displaying the results
The measurement result can be displayed by selecting the S11 parameter and an appropriate display graph

as described in Display setup. Note that the measured phase is relative to the calibration reference plane
as discussed in Reference plane extension and de-embedding. The reference plane can be shifted at any
time from the Enhancement window. Note that changes to the reference plane only take place when the
instrument is sweeping.

6.3.2 Insertion loss / gain

To carry out insertion loss measurements (S21) the VNA must be calibrated with the test cables in place,

either S21 calibration only, both S11 and S21 or full 12-term. The device to be tested (DUT) is then

connected between Ports 1 and 2 of the VNA as indicated in the figure below.

For best results, the arrangement shown on the right hand side of the figure should be used whenever
possible. When using an S11+S21 calibration this will minimize errors introduced by the load return loss.

On the other hand, when using a 12-term calibration, this will minimize repeatability / cable flexing errors
associated with the connecting cables.
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Connect DUT between Ports 1 and 2 to carry out S21
measurements. For best results use the arrangement shown

on the right.

Displaying the results
The measurement result can be displayed by selecting the S21 parameter and an appropriate display graph

and described in Reference plane extension and de-embedding. Note that the measured phase is relative
to the calibration reference plane as discussed in that section. The reference plane can be shifted at any
time from the Enhancement window. Note that changes to the reference plane only take place when the
instrument is sweeping.

6.3.3 Complete 2-port measurement

In order to measure all four s-parameters a 12-term calibration needs to be completed. The arrangement
shown on the right hand side of the figure above is likely to yield best results in terms of repeatability by
virtue of using only one test cable, reduces the effects of cable flexing.

Displaying the results
The measurement result can be displayed by selecting a different parameter for each of the possible four
display graphs, as described in the previous section. Note that the measured phase is relative to the
calibration reference plane as discussed in Reference plane extension and de-embedding. The reference
plane can be shifted (independently for each parameter) at any time from the Enhancement window. Note
that changes to the reference plane only take place when the instrument is sweeping.

Maximizing dynamic range
Refer to Calibration for best dynamic range – minimizing the effect of crosstalk for guidance on achieving
the largest dynamic range.

6.3.4 Group delay

Group delay is defined as the rate of change of phase with frequency:

In relatively non-dispersive components such as transmission lines, group delay is the transit time
through the line. However, some components such as filters can exhibit negative group delays so care is
needed when attaching an interpretation to group delay.

The PicoVNA 106 and 108 calculate the group delay by dividing the phase change between adjacent
sweep points and dividing by the size of the sweep step. It is usual to apply some degree of trace
smoothing to remove very rapidly changing perturbations from the trace. Care should be exercised to
ensure that genuine sharp group delay variations are not masked by the smoothing.
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Displaying the results
Group delay of any S-parameter can be measured. The result can be displayed by selecting the required
parameter and group delay graph from the Display window as described in Display setup.

6.3.5 Time domain measurements

The time domain facility allows the display of the time domain response of a network under test. For
example, time domain reflectometry (TDR) measurements can be made by first carrying out an S11

calibration using 1024 sweep points. Similarly, time domain transmission (TDT) measurements can be
made by first completing an S21 calibration using 1024 sweep points. The steps necessary are shown in

the flowcharts below.

Performing a TDR measurement

Performing a TDT measurement

Note that carrying out time domain measurements requires a lot of mathematical processing and
therefore each sweep will be noticeably slower when displaying time domain.

In TD mode, the plot markers display resistance and distance values for S11 and S22, and distance values

for S21 and S12, as well as levels.
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Examples of TDR measurements using the PicoVNA
The trace below shows the time domain response of a 50 cm, 50 Ω coaxial cable with an open circuit
termination. The trace goes to +1 relative to the reference indicating a reflection coefficient of +1 for an
open circuit. The window used is rectangular.

Measured 50 cm line terminated in an open circuit.

The trace below is the same as above except that the ringing either side of the transition has been
reduced by the use of a fifth-order Kaiser–Bessel window. This reduces the ringing but also slows the rise
time.

Same as previous figure but using the Kaiser–Bessel window.

The type of window, the order of the Kaiser–Bessel window, and the time span over which the signal is
displayed can be selected in the TDR options window, shown below.
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Time Domain Options window allows measurement setup

Note: To set a time range either starting or ending beyond 161.66 ns, use the Enter T1, T2 facility.
However, the displayed total time span must be less than 166.66 ns.

The plot below shows the same cable terminated with a short circuit. The window is fifth-order Kaiser–
Bessel. This time the trace goes to –1 relative to the reference, indicating a reflection coefficient of –1
for the short circuit.

Measured response of 50 cm shorted cable using Kaiser-Bessel fifth-order window

The trace below shows the effect of increasing the order of the Kaiser–Bessel window to 10. The ripple
has been completely removed but the slope of the edge has been further reduced.
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Measured response of 50 cm shorted cable using tenth-order Kaiser-Bessel window.

A more complicated example
The trace below shows the response of a 30 cm, 50 Ω line followed by 30 cm of 25 Ω line terminated in a
short circuit. The window is third-order Kaiser–Bessel. The trace shows the multiple reflections from the
discontinuity of impedance at the connection between the lines and the short circuit termination.

Measured response of multiple reflections. See text for details.

The last example is the same 50 Ω / 25 Ω cable combination but this time the termination is an open
circuit. The response is also displayed over a longer period.

Measured response of multiple reflections. See text for details.
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Time domain transmission 
Time domain transmission (TDT) is similar to the TDR technique except that the transmitted signal is
observed. Traditionally, this is accomplished using a step source and a sampling scope, as with the TDR,
but the transmitted signal at the output of the network is observed rather than the reflected signal at the
input to the network. This technique is useful for measuring the step response or rise time of amplifiers,
filters and other networks. 

Examples:

Expected responses from simple RC networks

Measured TDT for 100 pF series capacitor

Measured TDT for 100 pF shunt capacitor
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6.3.6 Reverse measurements on two port devices

In order to measure the reverse parameters (S12 and S22), it is necessary to complete a 12-term

calibration first (select ‘insertable’ or ‘non-insertable’ DUT on calibration window as shown in Display
setup). The other calibration options measure only forward parameters. After the 12-term calibration is
completed, simply select the reverse parameter(s) to be required on any displayed channel and start the
measurement. 

6.3.7 Powering active devices using the built-in bias-Ts

The PicoVNA 106 and 108 include two bias-Ts, which can be used to provide DC bias to the measurement
ports 1 and 2. The bias-Ts are rated at 250 mA and can support DC voltages up to 15 V. The DC injection
terminals are type SMB, male, and are located on the front panel. This facility can be used, for example, to
provide DC bias to an active device being measured.

CAUTION
To avoid causing permanent damage to the internal biasing circuit, do not exceed the voltage
and current ratings.

6.3.8 Save-on-trigger measurements (PicoVNA 108 only)

The Save on Trigger facility (Utilities menu) provides a convenient way of measuring multi-state devices
such as adjustable gain amplifiers and attenuators or phase shifters.

The Save on Trigger mode works by saving each triggered measurement sweep. Once the desired
numbered of sweeps have been captured (or you stop the measurement), you can selectively plot the
available data in various formats. The data can also be saved in a number of formats and sorted by
parameter if so desired. A further option is to save the entire data set (menu option in the File drop-down
menu) for later use. A copy of the Save on Trigger form (in Utilities menu) is shown below.
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Save on Trigger settings form and display graph

Setting the target and enabling Save on Trigger mode
Save on Trigger operation is enabled using the check box on the trigger selection
area on the main application dialog as shown on the right. When the box is first
checked, you will be asked to enter the target number of sweeps to be captured. If
the trigger mode is set to free run (auto trigger), you will be warned that the Save on
Trigger will only operate on a trigger event, i.e. any trigger mode except free run.

Plotting captured data
The captured data for each s-parameter measured can be plotted either in the form
of a family of traces (one for each measurement sweep) over the sweep frequency
(as in the graph above) or as a single trace displaying the value for a chosen frequency over the sweep
number. The latter is useful, for example, to examine the attenuation or phase value of a digital attenuator
at each setting at a given frequency.

An example of a plot showing the measured data
at a single frequency over the sweep number is
shown on the right. This is a measurement of 10
states of a programmable attenuator. The
horizontal axis represents each of the states
measured (each sweep measured a different state)
and the vertical axis is set to display the
magnitude of S21 in decibels. The user-requested

frequency for the plot is shown at the top.

The settings for the measurement sweeps to be
plotted can be specified as shown below.
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Maximum number of graph traces

Examples of valid values: “All” or “1,2,3,4” or “1,2,4-6,7” 

If plotting data for a single frequency, specify it here

Select format for the data plots

Set the vertical axis limits

Plot data can be normalised to any of the captured sweeps

When plotting s-parameter data over the
measurement sweep (as on the graph above) the
maximum number of traces (one for each
measurement sweep) is 16 for each S-parameter. If
all 4 S-parameters are being plotted this will result in
a total of 64 traces. In any case, the maximum
number of trace legends (which identifies the
parameter and sweep number of each trace) is
limited to 38.

Saving the captured data
The default save mode (‘sort by parameter’ and ‘single frequency’ not ticked) creates a data file for each
captured sweep. The example below shows the result of saving after capturing 12 measurement sweeps.
In this, the user requested the magnitude S11 and S21.

As can be seen, 12 data files have been created (each has the name provided by you, with the sweep
number appended, e.g. “Step_Attn_5.dat” is the data file for sweep 5) and each data file has 3 columns.
The first is the frequency in MHz, the second contains the requested S11 magnitude value and the third

the requested S21 magnitude.

The default save data mode creates a data file for each sweep.

External trigger considerations
The save on trigger mode programs the instrument to perform a specified number of sweeps, each
synchronized to an external trigger. You must consider the maximum possible repetition rate of the
external trigger. This rate is a function of factors such as the number of sweep points, bandwidth in use
and crucially the speed of the host PC’s operating system in allocating USB communication resources. If
the trigger rate exceeds the maximum, the host PC may miss some trigger events.

The timing diagram that applies to the Save on Trigger mode is shown below. In this it is assumed that
the external trigger is set to rising edge.

The measurement sweep time TSweep is a function of the number of sweep points and measurement

bandwidth in use. For example, a plan with 201 points using a bandwidth setting of 140 kHz will have
TSweep of 38.3 ms when measuring all 4 S-parameters. Ideally, the external system that generates the

trigger signal will synchronize the trigger signal to the falling edge of the trigger output from the VNA and
make allowance for the speed of the host PC and its operating system allocating USB communication
resources and processing all data and graphics in time.
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Typically, external trigger should occur 120 ms or more after the end of the sweep but will depend on
speed of host PC.

Note: In the case when the external trigger occurs sooner than the host PC can support after the end of
the sweep time, it is possible that some trigger events will be missed. Controlling the VNA through the
API (using the DLL file supplied) places a lighter load on the host PC (no graphics) so will support
significantly faster rates.

Single frequency option

The single frequency option causes a single line of data to be
saved.

If required, it is possible to request that only data
for a single frequency is saved. Ticking the ‘single
frequency’ box and entering the desired frequency
results in each saved data file containing a single
line of data as shown here on the right. In this
example the frequency requested was 1 GHz. The
nearest calibrated data point (1020.264 MHz) is
chosen as shown.

Sort by parameter option
It is possible to save the data to a disk file on a parameter by parameter basis by selecting the Sort by
parameter tick box in the Save captured data section of the form. So, for example, it is possible to save
all the values of S21 in a single file with the values for each sweep in separate columns.

For example, choosing to save all 4 s-parameters sorted by parameter will result in 4 separate disk files
being created as shown below:

The ‘Sort by parameter’ option creates a file for each s-parameter.

The figure below shows part of the contents of a sorted by parameter file created for the S11 values. In

this example, the user chose to save magnitude only. As can be seen, the first column has the frequency
value in MHz and subsequent columns contains the S11 value of the measurement sweeps captured.



Operation

74Copyright © 2017–2022 Pico Technology Ltdpvug-7

PicoVNA 6 and 8.5 GHz Vector Network Analyzers

Sorted by parameter files have a column for each sweep captured.

6.3.9 Mixer measurements (PicoVNA 108 only)

The PicoVNA 106 and 108 can perform measurements on mixers (frequency conversion devices) with the
use of an external LO source. The user interface software provides support for some commercially
available instruments as well as power sensors (power meters) needed to carry out signal level
calibration for improved measurement accuracy.

Typical mixer measurement set up
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Measurement selection
The appropriate mixer measurement form is launched from the Utilities drop down menu as shown below:

Mixer measurement selection

External instrument selection
Before setting the measurement parameters, select the source of the LO signal and the means for
calibrating the power level. This is done from the Instruments drop-down menu as shown below. The host

PC requires the Keysight® IO Libraries Suite to support communication with external instruments such as
power sensors through either the USB or GPIB interfaces. See www.keysight.com. Contact the factory if
your preferred instrument(s) is not on the list in case support may be added at a later date.

External instrument (LO source and power meter) selection

Conversion loss and return loss
This measurement is set up using the dialog shown above. It allows the frequency ranges to be set up as
well as the LO power level.

You can chose whether or not to measure return loss by means of the Ignore check box under the
Reflection calibration buttons. If the button is left unchecked, the instrument will perform a standard SOLT
calibration to allow corrected return loss values to be displayed.

Note: The return loss of either the RF port or the IF port will be measured and displayed. If the IF
frequency is swept, then the IF port return loss is measured otherwise the RF port return loss is measured
and displayed.

One important advantage of return loss calibration is that the measured conversion loss will corrected for
the effects, for example, of poor mixer return loss. This is sometimes referred to as VSWR correction and
is illustrated in the second figure below.

http://www.keysight.com
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Mixer measurement setup dialog
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VSWR Correction can improve conversion loss uncertainty

Isolation and conversion loss compression
The other main measurement options are port to port isolation and conversion loss compression as
shown under Measurement Selection above. Setting each of these up will require selection of the external
instruments as described above under External instrument selection. The corresponding form for each of
these set of measurements provides graphical indication of the calibration steps.

The figure below shows the conversion loss compression setup dialog. As indicated, the need for an
external power meter can be bypassed albeit at the risk of reduced measurement accuracy. On
completion of the measurement the variation of conversion loss with RF port power level and the 0.1 dB
and 1 dB compression points are displayed.
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Conversion loss compression measurement dialog

6.4 Reference plane extension and de-embedding
The reference plane extension facility on the PicoVNA 106 and 108 allows you to shift the measurement
reference plane away from the value set during calibration. This can be useful in removing the effect of
interconnecting cables or microstrip lines from measurements. The instrument allows independent
reference plane extensions on each of the measurement parameters (S11, S22, S12 or S21).

The loss associated with any plane extension can be entered directly (see figure above) in terms of the
loss (in dB) at 1 GHz. The software assumes that the loss is 0 dB at dc and at other frequencies the
magnitude of the loss is given by the following expression.

Loss = Loss (1 GHz) x √(Freq / 1x109)

The enhance option in the Auto Ref facility allows the software to compute the loss as well as the
optimum phase offset at each frequency in the sweep plan. This can be very useful to cancel out the
effect of loss but note that some residual errors after using this feature will remain, for example
mismatch errors.

The Auto Ref feature assumes a perfect open for reflection measurements. That is, it tries to provide an
offset to leave 0° reflection phase. Similarly, when dealing with transmission measurements, it assumes
a perfect zero length through connection.
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An example of an application requiring the use of reference plane extension is shown below. In this, it is
desired to measure the S11 of a device mounted on a microstrip test jig with SMA connectors. In order to

remove the effect of the interconnecting line to the input of the device, the following procedure may be
followed:

· Perform an S11 calibration at the end of the N to SMA adaptor on Port 1 

· Connect the test jig without the DUT mounted on it

· Display the phase of the S11 on active display channel

· Click Auto Ref in the Enhancement window

· Click Apply in the Enhancement window

The above steps will move the reference plane to the end of the microstrip line. This can be verified by
noting that the displayed phase is close to 0° over the entire measurement band. Imperfections
associated with the microstrip line and coaxial connector, such as loss and dispersion, will mean that
some residual phase will remain. However, with careful design and employing good RF practice for the
construction of the jig, this error should remain small.

After the above steps are completed, the DUT can be mounted on the jig and its S11 parameter measured.

Example of S11 measurement requiring reference plane extension

Note:  The reference plane extension moves the reference plane for each parameter measurement
independently. So, if required for example, different values can be used for S11 and S21. A reference plane

extension value entered, applies to the active channel measurement parameter (either reflection or
transmission).

 In the example above, correction was applied to the S11 phase but not S21. An often-used way to correct

the S21 phase is by using a calibration jig with length of microstrip line equal to the sum of the two

sections of line used either side of the DUT jig (see figure below). Proceed as follows to make S11 and

S21 measurements of the DUT.

Reference plane extension for S11 correction

· Perform a 12 term calibration (exclude test jig). Ensure that the test cable has connectors of different
sex at each end. Adaptors may be needed to connect the DUT.

· Connect the input port of the test jig without the DUT mounted on it to Port 1

· Display the phase of the S11 on the active display channel

· Click Auto Ref in the Enhancement window

· Click Apply in the Enhancement window

Normalization for S21 correction

· Connect the through microstrip test line between Ports 1 and 2 of the VNA
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· Display the phase of S21 on a non-active channel (keep active channel for S11)

· Start the measurement and store data on the S21 channel only to memory (use the memory window)

· Select Data / Memory for the math function in the Memory window

· Select the Memory Math display in the main window

Correcting S21 and S11 phase measurements. Reference plane extension corrects S11 measurements and

normalization to a test line corrects S21.

The above steps will allow the DUT's S11 and S21 (or S22 and S12) parameters to be measured with the

right phase correction. In addition, the loss of the microstrip line will be accounted for. The same
approach can be used to measure S12 and S22. Note, however, that there will be an error on both

measurements due to the imperfections of the microstrip line and connector interface. With careful
design of the jig these can be kept acceptably small but further accuracy can be achieved by making use
of the de-embedding facility described below.
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De-embedding facility
A typical measurement jig, as shown below, includes input and output networks which introduce errors to
the measured values of the device under test (DUT). For best measurement accuracy, these networks can
be specified (in the form of 2 port s-parameter files) and then used to extrapolate the DUT’s
characteristics.

 

De-embedding allows the effects of the test jig’s input and output networks
to be removed.

The PicoVNA 106 and 108 allow you to specify S-parameter files (must be full 2-port data) for the input
and output networks as shown in the figure above so that the de-embedding takes place automatically as
the instrument measures the test jig. After first calibrating as usual, follow the steps below to enable de-
embedding.

1. Select the S-parameter file(s) that represent the embedding network(s) by clicking on the embedding
network check box(es) as shown in Measurement enhancement. Check box Port 1 Network represents
the input network as shown in the figures in Reference plane extension and de-embedding, and Port 2
Network represents the output network. The files selected must be full 2-port S-parameter files in
Touchstone format.

2. Click on the radio button in the Measurement enhancement window to enable de-embedding.

Once the above steps are completed, starting the measurement will display de-embedded results.

The de-embedding facility relies on S-parameter data for the input or output network (or both) being
available. This data must be in the form of 2-port S-parameter files in Touchstone format.
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6.5 Saving data
Measured data can be saved to a file by selecting File > Save Measurements in the main menu. Various
formats are available as shown. In all cases, frequency is saved in megahertz. Note that only the
Touchstone format can later be read back into the instrument’s memory trace.

The Save Measurements window is used to save data

Note: For true compatibility with the Touchstone format, only 1-port or full 2-port S-parameters should be
saved. For example, selecting S11 and S21 (but not S12 and S22) is not Touchstone compliant.

If required, the data can be saved with the memory math function applied as described earlier under
Memory facility. In order to do this, check the Apply Memory Math box. Note that the memory math
display function on the main window must be set otherwise the Apply Memory Math check box will be
disabled.

When saving data in Touchstone format, ensure that you provide the file name extension when entering

the file name. Typically, for 1-port networks, the extension “.s1p” is used and  “.s2p” for 2-port
networks. This will help when reading back the data files since, by default, only files with these
extensions will be displayed.

Note: Data will be saved with any system Z0 conversion applied.

6.6 Loading data
Measured data (or data from a circuit simulator) can be read into the instrument’s memory trace(s) or live
trace. This can be done by selecting File > Load Measurement in the main menu. The file containing the
data (in Touchstone) format is selected by clicking Select Data File.

The data will be read from the file and copied to the appropriate display channel(s). So, for example,
assume you read a data file holding full 2-port data. Further, you have only two channels on display
showing, say, S11 and S21, so only the S11 and S21 data from the data file read will be copied to the

memory traces of the displayed channels. Note: system impedance conversion will apply if turned on in
the Measurement enhancement window.
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Loading data is done with the File > Load
Measurement menu command

6.7 Plotting graphics
You can plot the graphics displayed on the main window using the File menu. A printer setup window will
appear from you can choose the desired printer and set its properties. If required, you can add a label to
the plotted graphics by clicking File > Print / Save Graphics Label.

A label can be added when plotting or saving graphics  

A similar plotting facility exists on the P1dB and AM to PM utilities' control windows.

6.8 Saving graphics
The graphics shown on the main window can be saved in BMP, PNG, GIF, TIF or JPEG formats. This
allows measurement results to be directly pasted into most electronic documents. The facility to save
the graphics can be found under the main File menu. After clicking, a dialog box will appear allowing you
to select the name of the file, its location and format from a drop-down box. As described in the previous
section, a label can be added by clicking File > Print / Save Graphics Label.

The save graphics facility is not available on the P1dB and AM to PM utilities. Instead, the graphics on
these can be captured by pressing the Alt+PrtScr key combination. The image can then be pasted to the
chosen document from the Edit menu.
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6.9 Signal generator utility
This utility allows the instrument to act as a simple CW or sweep signal generator with variable output
power. The output can be either port 1 or port 2. The VNA measurement sweep must be stopped first and
the control window, shown below, called from the Utilities menu:

Signal generator utility control window

Maximum output level when using the generator utility: see Performance specifications.

In sweep mode, the maximum number of points in the plan is 1001 with a dwell time range of between 250
and 60 000 μs. Note that this dwell time excludes the time to program the synthesizers.

Trigger (PicoVNA 108 only)
The sweep generator mode supports the following trigger modes:

· Free running

· External rising edge 

· External falling edge

These three modes can be selected from the main VNA dialog, in the Trigger selection box. Note that the
Manual trigger mode is not supported by the sweep generator.

6.10 Output power at the 1 dB gain compression point
utility

This utility allows the measurement of the power output at the 1 dB gain compression point (P1dB) of

active devices such as amplifiers. The measurement can be done at a single frequency or over the entire
frequency plan specified at the last S-parameter measurement calibration. Start the utility from the
Utilities menu in the main window.

P1dB calibration

Calibration minimizes errors by removing small variations associated with the instrument’s hardware. The
procedure is simple, as shown below.

· Ensure that an S21 (or S11 + S21, or 12-term) calibration has been carried out

· Connect Port 1 to Port 2 as shown on the left-hand side of the figure below

· Enter Input Attenuation and Output Attenuation values (or select Read from file)
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· Enter the test frequency (or select Use sweep plan) and click Calibrate

P1dB test

The basic connection arrangement is shown on the right hand side of the figure below. Note that the input
and output attenuators should be carefully selected to ensure that the DUT compresses whilst preventing
the power at Port 2 of the instrument exceeding the nominal limit of +10 dBm. It is recommended that the
following guidelines are used to estimate the value of the input and output attenuators needed.

P1dB(DUT) – G(DUT) –1 + Att1 = –5 ± 2 dBm

P1dB(DUT) – Att2 + 5  < 10 dBm

where: P1dB(DUT) = output power of DUT at the 1 dB gain compression point

G(DUT) = linear gain of DUT

Att1, Att2 = input and output attenuators

The P1dB test relies on the internally stored factory calibration of the instrument’s port 2 receiver

sensitivity. This is used as a power sensor to calibrate the power available from port 1 as well as
measuring the output power from the device under test. The test does not rely on the setting accuracy
of the port 1 output level.

Basic connection guide for P1dB measurements. Calibration connection is shown on the left.

The instrument makes the measurement by setting the signal source (Port 1) frequency to the chosen
value and then stepping its power from –20 to +3 dBm (PicoVNA 106) or to +6 dBm (PicoVNA 108) in 1
dB steps. The gain at each power setting is recorded. On completion of the power sweep, a second order
curve is fitted over a narrow section centered on the point closest to the 1 dB gain compression point.
The coefficients of this curve allow the actual P1dB point to be calculated.

Note: Choose the input attenuator with care. Ensure that there is no gain compression at the start of the
power sweep (–20 dBm at Port 1) and that at least 0.7 dB of gain compression is reached at the end of
the sweep (+3 or +6 dBm at Port 1). A ‘?’ will be displayed if insufficient compression has been achieved.

After the attenuator values have been established and the DUT is in place (and powered up as
appropriate), enter the values into the P1dB control window (figure below). Note that the output attenuation

value directly affects the P1dB value, so it is important to enter an accurate value that takes into account

all losses in the output path, including any connecting cable that may have been used.
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Clicking Start will perform the test, plot the gain and output power curves, and compute the P1dB. This,

together with the linear gain, will be displayed in the text boxes to the right of the Start button. The results
can then be printed (the window as displayed will be printed) or saved as a text file by clicking Print or
Save.

The P1dB measurement utility control window

Attenuation values from file
When measuring P1dB using the frequency sweep plan, it is possible to read the input and output

attenuation values from a file. The data is held in a simple text file with one line for each frequency point.
The format must be as follows:

Frequency (MHz), magnitude (dB), phase (degrees)

Note: The number of lines in the file must match the number of sweep points in the sweep plan.
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6.11 AM to PM conversion utility
This utility allows the measurement of the AM to PM conversion factor of a DUT. Generally, it is used for
evaluating the linearity of active devices such as amplifiers. The utility is started from the main Utilities
menu, shown below:

The AM to PM measurement utility control window

In order to use this facility an S21 calibration (or S11+S21, or 12-term) must have been carried out. For best

results, some averaging (e.g. 16) should be used. Further, a second through calibration is suggested to
remove residual phase variations. The steps are summarized as follows.

AM to PM utility (calibration)

· Perform a normal S21 calibration (or S11+S21, or 12-term); see left-hand connection diagram in Quick

start guide

· Call up AM to PM Utility (window shown above)

· Enter frequency required (Test Freq) in megahertz

· Click Calibrate (connection as on left-hand side of figure below)

AM to PM utility (test)

· Connect DUT with attenuators as shown on right hand side of the figure below

· Enter attenuator values, input power at which result is required and measurement title

· Power up DUT if necessary

· Click Start

On completion of the AM to PM test, a graph of AM to PM as a function of input power at the DUT input
will be plotted. In addition, the AM to PM factor at the specified input power entered will be displayed in
the text box in the Measure section of the window.
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Figure: Calibration (left) and test (right) connections for AM to PM test

Note: For best AM-PM results apply some averaging (e.g. 16) and carry out an AM-PM calibration (left
hand side of figure). A ‘?’ will displayed if the requested Pin for readout is outside the available range.

6.12 Phase meter utility (PicoVNA 108 only)
This utility allows port 1 and port 2 of the instrument to be used purely as receivers to measure amplitude
and relative phase. The control window for this utility is shown below. The key function on this is the
control to set the frequency. The frequency range is 0.3 to 8500 MHz. Once it is set, the receivers will be
capable of capturing input signals within ±60 kHz (typically) of this value. The input level range of signals
that the utility can work over is +10 to -46 dBm, typically.

Phase meter control window

Phase meter utility display resolution
The amplitude and phase displayed resolution is dependent on the receiver bandwidth selected as shown
below.

Bandwidth setting Display resolution

> 1 kHz 0.0
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> 10 Hz 0.00

10 Hz 0.000

Amplitude calibration
The phase meter utility uses the internally stored port 2 sensitivity. Unless otherwise corrected, the utility
assumes that port 1 has the same sensitivity as port 2 which is likely to lead to a larger error than would
otherwise be the case. To reduce this error in the port 1 level reading, click Calibrate and follow the
instructions.

The amplitude calibration feature is a simple two-step process where the connections to ports 1 and 2
are swapped, allowing the software to make the necessary correction at the selected frequency. Note
that some residual errors are likely to remain. These are associated with the impedance mismatch of the
ports and accuracy of the stored port 2 sensitivity. If amplitude accuracy is critical to the measurement,
you are advised to check the amplitude measurement error using an external dedicated power meter.

6.13 Compare data utility
The compare data utility provides a quick and simple way to compare two sets of full S-parameter
measurements taking into account the instrument’s measurement uncertainty and optionally, the
uncertainty associated with the reference measurement.  Typically this facility can be used to measure a
Check Standard and compare the measurement values produced by the PicoVNA 106 or 108 with those
supplied with the Check Standard. This is a simple and quick way of determining the adequacy of the
calibration to be used.

The compare data utility can be found in the Utility drop-down menu. This brings up the dialog shown
below.

To use the compare utility, follow these steps:

1. Perform a full S-parameter calibration for either an insertable or female non-insertable DUT.
2. Set display graph 1 to S11, 2 to S21, 3 to S12 and 4 to S22.
3. Measure the associated Check Standard.
4. Using File > Load Measurements command, load the reference measurement of the Check Standard

(supplied with the standard) to the memory traces. This must be a full Touchstone S-parameter
measurement - example file name:

SN10000X.s2p
5. Launch the compare data utility (Utility > Compare Data).
6. Load the PicoVNA 106 or 108 VNA uncertainty file. If all connections are made using PC3.5 test leads

and cal kits, use:

Instrument Uncertainty with Premium PC3.5 leads.dat
Otherwise use:

Instrument Uncertainty with Pico Standard SMA leads.dat
These SMA uncertainties are supported by Pico "Standard" test leads, fixed SOLT and E-Cal kits.

7. Load the reference measurement uncertainty file:

Check Standard Reference Measurement Uncertainty.dat
8. Check the Ignore reference uncertainty check box only if comparing two measurements of the same

Check Standard on the same VNA made at different times or in different environments.
9. Click the Compare button to perform the comparison and display the results.
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Data comparison dialog

Defining uncertainties
Measurement uncertainty is defined by means of text file as illustrated below. The definition is made up

of several segments. Each segment refers to reflection [REFLECTION] or transmission

[TRANSMISSION] with an entry for the applicable range in dB followed by the frequency range (in MHz).
After the frequency range entry, the magnitude uncertainty in dB is specified followed by the
corresponding phase uncertainty in degrees. 

The uncertainty definition is made up of several reflection and transmission
segments. A reflection segment is highlighted above.

It is possible to define the uncertainty by a polynomial. To do this, follow the [MAGDB] keyword with the

keyword [POLY]. Then, the uncertainty can be define by means of 3 coefficients, say, K0,  K1, and K2. The

uncertainty for given measured absolute magnitude value in dB, M, is given by:

Up = K0 + K1M + K2M2

The same approach can be used to defining the phase uncertainty. That is, add the keyword [POLY] after

the [PHASE] keyword.

The data compare utility resolves the total combined uncertainty as follows:
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In the above, UI is the uncertainty associated with the PicoVNA unit and UR is that provided with the

reference Check Standard.

6.14 Closing down the software
You should formally shut down the user interface window before switching off the VNA. This allows the
software to save the calibration and status and update the instrument’s log file. The sequence is shown
below:

Formally closing down the software saves the current calibration

Closing the program by clicking the top right-hand X button will end the program without saving anything.
A warning will be issued.
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7 Performance verification and maintenance
We recommend that the instrument is checked periodically for safety (chassis grounding, fan operation,
clear ventilation grilles and operator markings) and compliance with the stated electrical specification.
The table below shows suggested parameters that should be checked as part of the calibration process.
Note that the ventilation inlets should be checked as described later.

Measurement DUT Conditions Calibration type

S21 and S12, magnitude and

phase

20 dB attenuator 51 points sweep
0.3–6000 or 8500 MHz
1 kHz BW
+3 dBm test level

12-term

S11 and S22, magnitude and

phase

A known mismatch at ports 1
and 2 (–16 dB or worse return
loss)

51 points sweep
0.3–6000 or 8500 MHz
1 kHz BW
+3 dBm test level

12-term

or

S11, S21, S22 and S12,

magnitude and phase

Mismatched attenuator (> 10
dB attenuation and –16 dB or
worse return loss)

51 points sweep
0.3–6000 or 8500MHz
1 kHz BW
+3 dBm test level

12-term

Suggested annual instrument verification / calibration schedule

We recommended that you compare the measured results with the values provided with the standards
and verify that they are within the combined uncertainty of the instrument and the provided reference
measurements. The frequency should be set to agree with those available(s) for the standard used. The
recommended test arrangement is shown below. The results should be within the instrument’s quoted
uncertainty as detailed in the following section. Allowance should also be made for the uncertainty of the
standard reference values.

Performance verification arrangement

Tip: A data compare utility is provided in the PicoVNA 3 software that can be used to compare the
measurements, taking into account the uncertainty of the instrument.

Note: The Pico TA430 and TA431 check standards can be used in this verification but they have too much
uncertainty to make a confident verification to the full performance specification of the PicoVNAs.
Nonetheless, the uncertainty of the verification, given in the result from the compare utility, may be low
enough for the application. If sufficient, the use of either TA430 or TA431 of course significantly reduces
ownership costs and increases the regularity at which a verification can be made.
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7.1 Measurement uncertainty
The measurement uncertainty figures below are based on calibration (12-term, insertable device, with –
3 dBm test power and using 10 Hz bandwidth, no averaging) using the premium PC3.5 mm calibration kits
optionally supplied with the instrument. The figures for S21 and S12 assume that the DUT has a value of

S11 or S22 of less than 0.2 dB. Similarly, the figures for S11 and S22 assume the DUT has a value of S21 or

S12 of less than 0.2 dB. Other external factors such as temperature, connector and cables instabilities are

excluded.

For Pico premium PC3.5 test leads and standards

Reflection (S11, S22) measurement uncertainty

Power Frequency
Magnitude Phase Magnitude Phase

VNA 106 VNA 108

–15 dB to 0 dB Freq < 2 MHz
Freq > 2 MHz

0.7 dB
0.5 dB

8º
4º

0.7 dB
0.5 dB

8º
4º

–25 dB to –15 dB Freq < 2 MHz
Freq >  2MHz

0.8 dB
1.0 dB

6º
10º

0.8 dB
1.0 dB

6º
10º

–30 dB to –25 dB Freq < 2MHz
Freq > 2MHz

3.0 dB
2.5 dB

20º
15º

3.0 dB
3.0 dB

20º
20º

Transmission (S21, S12) measurement uncertainty

Power Frequency
Magnitude Phase Magnitude Phase

VNA 106 VNA 108

+0 dBm to +6 dBm Freq < 2 MHz
Freq > 2 MHz

0.4 dB
0.2 dB

6º
2º

N/A

+0 dBm to +10 dBm Freq < 2 MHz
Freq > 2 MHz

N/A
0.4 dB
0.2 dB

6º
2º

–40 dBm to 0 dBm Freq < 2 MHz
Freq > 2 MHz

0.2 dB
0.1 dB

2º
1º

0.2 dB
0.1 dB

2º
1º

–60 dBm to –40 dBm Freq < 2 MHz
Freq > 2 MHz

0.5 dB
0.3 dB

8º
4º

0.5 dB
0.2 dB

8º
4º

–80 dBm to –60 dBm Freq < 2 MHz
Freq > 2 MHz

2.0 dB
1.5 dB

15º
12º

2.0 dB
1.5 dB

15º
12º

The measurement uncertainty figures below are based on calibration (12-term, insertable device, with –
3 dBm test power and using 10 Hz bandwidth, no averaging) using SMA calibration kits optionally supplied
with the instrument. The figures for S21 and S12 assume that the DUT has a value of S11 or S22 of less than

0.2 dB. Similarly, the figures for S11 and S22 assume the DUT has a value of S21 or S12 of less than 0.2 dB.

Other external factors such as temperature, connector and cables instabilities are excluded.

For Pico standard SMA test leads, standards and E-Cal standards

Reflection (S11, S22) measurement uncertainty

Power Frequency
Magnitude Phase Magnitude Phase

VNA 106 VNA 108

–15 dB to 0 dB Freq < 2 MHz
Freq > 2 MHz

0.99 dB
0.71 dB

11.31º
5.66º

0.99 dB
0.71 dB

11.31º
5.66º

–25 dB to –15 dB Freq < 2 MHz
Freq >  2MHz

1.13 dB
1.41 dB

8.5º
14.14º

1.13 dB
1.41 dB

8.5º
14.14º

–30 dB to –25 dB Freq < 2MHz
Freq > 2MHz

4.24 dB
3.54 dB

28.3º
21.21º

4.24 dB
3.54 dB

28.3º
21.21º
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Transmission (S21, S12) measurement uncertainty

Power Frequency
Magnitude Phase Magnitude Phase

VNA 106 VNA 108

+0 dBm to +6 dBm Freq < 2 MHz
Freq > 2 MHz

0.57 dB
0.28 dB

8.48º
2.82º

N/A

+0 dBm to +10 dBm Freq < 2 MHz
Freq > 2 MHz

N/A
0.57 dB
0.28 dB

8.48º
2.82º

–40 dBm to 0 dBm Freq < 2 MHz
Freq > 2 MHz

0.42 dB
0.14 dB

2.82º
1.41º

0.42 dB
0.14 dB

2.82º
1.41º

–60 dBm to –40 dBm Freq < 2 MHz
Freq > 2 MHz

0.71 dB
0.42 dB

11.31º
5.66º

0.71 dB
0.42 dB

11.31º
5.66º

–80 dBm to –60 dBm Freq < 2 MHz
Freq > 2 MHz

2.83 dB
2.12 dB

21.21º
16.97º

2.83 dB
2.12 dB

21.21º
16.97º

7.2 Routine maintenance
Ventilation grilles
Check that all ventilation grilles are clear of any debris, dust or any other material that may impede the
flow of air. Particularly, check the vents in the bottom panel of the instrument. It is advisable to brush
these to remove any gradual build up of dust.

Failure to clean the ventilation grilles may lead to overheating and eventual failure of the instrument.

Front panel connectors
Routinely inspect the Port 1 and Port 2 N-type connectors for signs of damage or dirt. Use connector-
saver adaptors (male to female through) where frequent connection and disconnection are likely.
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8 Performance specification
The instrument’s performance specification is given below. Unless otherwise stated, the figures apply
with 10 Hz resolution bandwidth, at –3 dBm test power, 12-term calibration (for insertable DUT) using the
enhanced isolation option, at an ambient temperature of 23 ± 1 °C and 60 minutes after power up.

Measuring functions

Measuring parameters S11, S21, S22, S12

P1dB (power at 1 dB gain compression)

AM to PM conversion factor (PM due to AM)
PicoVNA 108 only: Mixer conversion loss, return
loss, compression and port isolation.

Error correction 12 error term full S-parameter correction (insertable
DUT)
12 error term full S-parameter correction
(noninsertable DUT)
8 error term full S-parameter unknown through
correction (noninsertable DUT)
S11 (1-port correction)
De-embed (2 embedding networks may be specified)
Impedance conversion
S21 (normalize, normalize + isolation)
S21 (source match correction + normalize +
isolation)
Averaging, smoothing
Hanning and Kaiser–Bessel filtering on time-domain
measurements
Electrical length compensation (manual or auto)
Effective dielectric constant correction

Display channels 4 channels (CH1, CH2, CH3, CH4)

Traces 4 live traces per display channel

Display formats Amplitude (logarithmic and linear), phase, group
delay, VSWR, real, imaginary, Smith chart, polar, time
domain

Memory trace Four per display channel

Limit lines 6 segments per channel (overlap allowed)

Markers 8 markers

Marker functions Normal, Δ marker, fixed marker, peak / min. hold, 3
dB and 6 dB bandwidth

Signal source characteristics

Frequency range PicoVNA 106: 300 kHz to 6.02 GHz
PicoVNA 108: 300 kHz to 8.50 GHz

Frequency setting resolution 10 Hz

Frequency accuracy ±10 ppm (23 ± 3°C)

Frequency temperature stability ±0.5 ppm/°C (15 to 35°C)

Harmonics (–3 dBm output level) –20 dBc max

Non-harmonic spurious (typical) –40 dBc typical

Phase noise (10 kHz) –90 dBc/Hz (0.3 MHz to 1000 MHz)
–80 dBc/Hz (1000 MHz to 4000 MHz)
–76 dBc/Hz (> 4000 MHz)

Output power PicoVNA 106
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Signal source characteristics

Up to 4 GHz: +6 to –20 dBm
> 4 GHz: +3 to –20 dBm
PicoVNA 108
Up to 6 GHz: +10 to –20 dBm
> 6 GHz: +6 to –20 dBm

Power setting resolution 0.1 dB (nominal)

Output power accuracy ±1.5 dB

Reference input frequency 10 MHz ±6 ppm

Reference input level 0 ±3 dBm

Reference output level 0 ±3 dBm

Sweep functions

Sweep type Linear frequency sweep, CW time-based sweep,
power sweep (P1dB utility)

Trigger modes
Option to capture up to 1024 sweeps of data in all
modes except free run.

Free run
Positive trigger
Negative trigger
Manual trigger

Sweep time
10 MHz to 6 or 8.5 GHz, 201-point trace length. For
other lengths
and bandwidths the sweep time is approximately:
TSWP(s) = N × (TMIN + FBW / RBW)

where:
N = number of frequency points
TMIN(s) = minimum time / point (s2p: 167 μs; s1p: 85

μs)
FBW = bandwidth settle factor (s2p: 1.91; s1p: 0.956)

RBW = resolution bandwidth (Hz)

For sweep repetition period, add software rearm
time:
TARM = average 6.5 ms or worst case 50 ms

For markers on, increase TARM by 39 ms

Bandwidth S11, S21, S11+S21

calibration

Full 12- or 8-term
calibration

140 kHz 19 ms
(PicoVNA 106)
20 ms
(PicoVNA 108)

37 ms
(PicoVNA 106)
38 ms
(PicoVNA 108)

10 kHz 37 ms 72 ms

1 kHz 0.21 s 0.42 s

100 Hz 1.94 s 3.87 s

10 Hz 19.2 s 38.4 s

LF Adder (for
each low-
frequency point
< 2.5 MHz)

1.25 ms/pt 2.5 ms/pt

Number of sweep points, VNA mode 51, 101, 201, 401, 801, 1001, 2001, 4001, 5001, 6001,
7001, 8001, 9001, 10 001

Number of sweep points, TD mode 512, 1024, 2048, 4096

Receiver characteristics

Resolution bandwidth 140 kHz, 70 kHz, 35 kHz, 15 kHz, 10 kHz, 5 kHz,
1 kHz, 500 Hz, 100 Hz, 50 Hz, 10 Hz

Averaged displayed noise floor (dB):
S21 calibration

10 Hz bandwidth
16 averages
Test ports terminated as during isolation calibration
step

Band Typ. Max.

PicoVNA 106

0.3 to 10 MHz –110 –100

10 MHz to 4 GHz –118 –108

4 to 6 GHz –110 –100

PicoVNA 108

0.3 to 1 MHz –100 –90

1 MHz to 6 GHz –124 –110

6 to 8.5 GHz –120 –100
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Receiver characteristics

Dynamic range (dB)
Bandwidth 10 Hz
Maximum test power +6 dBm (6 GHz), 0 dBm (8.5
GHz)
16 averages 
Test ports terminated as during the isolation
calibration step. Isolation calibration refreshed as
described in Calibration for best dynamic range.

See figure below

Temperature stability, measured after an S21

calibration, (typical)

0.02 dB/°C (f < 4 GHz)
0.04 dB/°C (f ≥ 4 GHz)

Trace noise (dB RMS)
Full band
Test level 0 dB
201-point sweep covering 1 MHz to 6 GHz or 8.5
GHz

Bandwidth Typical Maximum

10 kHz PicoVNA 106: 0.000 8
PicoVNA 108: 0.000 6

0.002

70 kHz 0.003 0.005

140 kHz PicoVNA 106: 0.005
PicoVNA 108: 0.006

0.01

Test port characteristics

Load match Corrected: 40 dB min., 46 dB typ.
Uncorrected: 16 dB (PicoVNA 106), 15 dB (PicoVNA
108) typ. uncorrected

Source match Corrected: 40 dB min., 46 dB typ.
Uncorrected: 16 dB (PicoVNA 106), 15 dB (PicoVNA
108) typ. uncorrected

Directivity (using PC3.5 cal kit) Corrected: 40 dB min. corrected, 47 dB typ.
corrected

Crosstalk (dB, corrected)
Test ports terminated with short circuits.
Value is average displayed noise level.

Band Typical Maximum

PicoVNA 106

0.3 kHz to 2 MHz –100 –90

2 MHz to 4 GHz –110 –90

4 GHz to 6 GHz –100 –90

PicoVNA 108

0.3 kHz to 2 MHz –100 –90

2 MHz to 6 GHz –110 –90

6 GHz to 8.5 GHz –100 –90

Main test ports maximum input level
(1 dB compression)

+10 dBm, typ (0.1 dB compression)

Main test ports maximum input level
(no damage)

+20 dBm (PicoVNA 106)
+23 dBm (PicoVNA 108)

Main test ports connectors Type N (female)

Bias-T maximum current 250 mA

Bias-T maximum DC voltage +15 V

Bias-T current protection Built-in resettable fuse

Bias-T DC port connectors SMB (female on front panel)

Sweep trigger input voltage Low: –0.1 to +1.0 V
High: +2.0 to +4 V

Mixer measurements (PicoVNA 108 only)

Frequency range 0.3 to 8500 MHz

Input power sweep range –17 to +10 dBm (6 dBm for F > 6 GHz)
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Mixer measurements (PicoVNA 108 only)

Input power sweep step 0.5 dB (nominal)

LO source External, required

Power level calibration External power sensor supported with option to use
internal receivers with reduced accuracy

Measurements Conversion loss, return loss, isolation and
compression

Accuracy (conversion loss with return loss
correction applied)

0.2 dB (typical)

Display format Graphical, conversion loss, return loss, isolation and
compression

P1dB utility

Frequency range 0.3 to 6020 MHz or 8500 MHz

Input power sweep range PicoVNA 106: –20 to +3 dBm 
PicoVNA 108: –20 to +6 dBm

Input power sweep step 1 dB (nominal)

P1dB calculation method 2nd order curve fit

Display format Graphical, gain and output power

Accuracy 0.5 dB (typical)

AM to PM utility

Frequency range 0.3 to 6020 MHz or 8500 MHz

Input power sweep range –20 to 0 dBm

Input power sweep step 1 dB (nominal)

AM to PM point calculation method 2nd order curve fit

Display format Graphical, phase conversion (deg / dB)

Accuracy (Port 2 power +5 to –20 dBm) 1° (typical)

Signal generator utility

Frequency range 0.3 to 6020 MHz or 8500 MHz

Output power PicoVNA 106: –20 to +3 dBm 
PicoVNA 108: –20 to +10 dBm

Setting resolution 0.1 dB

Output power accuracy ±1.5 dB max

Group delay

Range (180° maximum phase shift per frequency
step) where Δf is the aperture frequency

Aperture frequency Frequency sweep step size

Accuracy

Data handling

Calibration data Store / Recall on disk

Calibration kit data Store / Recall on disk

Print measured data (graphics) To any printer installed on host PC

Save measured data (graphics) To disk

Measured data Store on disk

Measured data (Touchstone format) Store on disk
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Data handling

Measured data (Touchstone format) Recall to memory trace from disk

Statement of Volatility: No user data, calibration data or user settings are stored on the device.

Miscellaneous

PC data interface USB

PC minimum requirements Microsoft Windows 7, 8 or 10
2 GB RAM or more
200 MB hard disk storage on C: partition
Display resolution of 1280 x 720 to run PicoVNA
software

External dimensions (L x W x H) 286 x 174 x 61 mm

Weight 1.85 kg

Temperature range (operating) +5 °C to +40 °C

Temperature range (storage) –20 °C to +50 °C

Humidity 80% max. (non-condensing)

Power source DC, 12 to 15 V
PicoVNA 106: 1.85 A peak, 22 W max.
PicoVNA 108: 2.1 A peak, 25 W max.

Dynamic range (PicoVNA 106)

Dynamic range 10 MHz to 6 GHz
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Dynamic range 0.3 to 10 MHz

Typical system dynamic range (Ptest = +6 dBm, BW = 10 Hz)

Dynamic range (PicoVNA 108)

Dynamic range 10 MHz to 8.5 GHz
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Dynamic range 0.3 to 10 MHz

Typical system dynamic range (Ptest= +10 dBm, BW = 10 Hz)
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9 Troubleshooting guide

CAUTION
The product and accessories contain no user-serviceable parts. Repair, servicing and
calibration require specialized test equipment and must only be performed by Pico
Technology or an approved service provider.

Symptom Possible Cause Solution

Instrument does not power up · Power not applied
· Incorrect supply

· Check DC connection
· Check external supply

PicoVNA 3 software unable to
communicate with the instrument

· Driver not installed
· Link interrupted

· See Switching on
· Restart instrument and software

Instrument sweeping but display not
refreshing

· Data link interrupted · Restart instrument and software

‘Last Calibration not found’ message
on power up

· C:

\User\Public\Documents\

PicoVNA2 (or ...PicoVNA3)
directory deleted or corrupted

· Restore folder. Set up display and
calibrate. Exit the software using File >
Exit menu command. This will save the
current calibration in a file named

defaultcal.cal.

Diagnostics Tests (under Tools menu)
fail

· Data corruption · Restart instrument and software.
Ensure that test cable used is in good
condition.

Error reading data files · Invalid format
· Too many lines
· Leading space(s)

· Check for correct format / ‘#’ line
· 10 001 lines maximum
· Remove leading spaces from data lines

Diagnostics tests
It is possible to run self-check tests on the instrument. This facility (Diagnostic Tests) is available from
the Tools menu shown above. In order to complete the tests a low loss cable is required to link Port 1 to
Port 2. The tests carry out the following checks.

· Synthesizers: test that they remain in lock over the frequency range

· Test signal: test the level range and step size

· Receiver levels: test that the receiver is operating at normal signal levels

· Receiver crosstalk: test that raw crosstalk remains below limit

· Receiver DC offset: test that this is at normal level
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The Diagnostics Tests perform internal checks on key components

If any of the tests returns an error, check connectors and linking cable. If this does not resolve it, restart
the instrument and the software. After pressing reset, wait until the front-panel channel activity indicators
have stopped flashing to continue with the tests.

Calibration error terms and raw receiver data
The diagnostic tests dialog (figure above) also provides the facility for retrieving the calibration error
terms and raw receiver data. The latter can be helpful for users wishing to carry out their own calibration
procedure.

Back up/restore EEPROM
This facility allows the internal ROM (read-only memory) of the instrument to be backed up or restored.
This facility should only be required by service or repair personnel.
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10 Warranty
Pico Technology warrants upon delivery, and for a period of three years unless otherwise stated from the
date of delivery, that the Goods will be free from defects in material and workmanship.

Pico Technology shall not be liable for a breach of the warranty if the defect has been caused by fair wear
and tear, willful damage, negligence, abnormal working conditions or failure to follow Pico Technology's
spoken or written advice on the storage, installation, commissioning, use or maintenance of the Goods or
(if no advice has been given) good trade practice; or if the Customer alters or repairs such Goods without
the written consent of Pico Technology.
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